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How to get help

Contents
This section contains the following topics:

• "Introduction" (page 11)

• "Getting help from the Nortel web site" (page 11)

• "Getting help over the telephone from a Nortel Solutions Center" (page
12)

• "Getting help from a specialist by using an Express Routing Code"
(page 12)

• "Getting help through a Nortel distributor or reseller" (page 12)

Introduction
This chapter explains how to get help for Nortel products and services.

Getting help from the Nortel web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support web site:

http://www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

• download software, documentation, and product bulletins

• search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

• sign up for automatic notification of new software and documentation
for Nortel equipment

• open and manage technical support cases
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12 How to get help

Getting help over the telephone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical Support
web site, and you have a Nortel support contract, you can also get help over
the telephone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following web site to obtain the telephone
number for your region:

www.nortel.com/callus

Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an Express
Routing Code (ERC) to quickly route your call to a specialist in your Nortel
product or service. To locate the ERC for your product or service, go to:

www.nortel.com/erc

Getting help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a distributor
or authorized reseller, contact the technical support staff for that distributor
or reseller.
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New in this Release

Contents
This section contains the following topics:

• "Introduction" (page 13)

• "Features" (page 13)

• "Other" (page 14)

Introduction
The following sections describe what is new in Common Network Directory
(CND) 2.2.

Features
Refer to the following sections for information about feature changes:

The Comma Separated Values (CSV) subscriber export feature exports
subscribers from CND into a CSV file. See "CSV Subscriber Export" (page
139).

The CSV subscriber synchronization feature imports new subscribers and
updates existing subscribers in CND using a CSV file. See "CSV Subscriber
Synchronization" (page 103).

Use the scheduled backup feature to schedule a backup of CND that occurs
automatically at some point in the future. See "Scheduling automated
backups" (page 66).

CND Manager ensures that passwords conform to a set of rules. See "CND
Manager password rules" (page 40).

The CND Schema is extended in the CND 2.2 release. See .
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Other
Revision History

February 2008 Standard 02.05. This document is up-issued to reflect changes in technical
content in the following sections/procedures:

• Procedures

— Performing a fresh installation

— Using the repair option

— Using the remove option

— Changing an existing application account password

— Changing the Administrator account password

— Deleting an existing application account

— Scheduling a backup of CND data

— Exporting subscribers from CND

— Upgrading the Nortel schema

— Starting the CND Service manually

— Changing the CND service startup type to manual

— Configuring the CND idle connection timeout

— Synchronizing subscribers in CND

• Sections:

— Nortel subscriber schema attributes

— Effects of upgrade

— Multi-valued attributes

— CSV subscriber export limitations

— CSV subscriber synchronization limitations

— Features

— Co-residency supported

— Scheduling automated backups

— Logging

• Table:

— Handled error conditions

December 2007 Standard 02.04. This document is up-issued to support Nortel Communication
Server 1000 Release 5.5.
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June 2007 Standard 01.03. This document is up-issued to reflect changes in technical
content in the following sections/procedures:

• Procedures:

— Upgrading from CND 1.0 or 2.0 to CND 2.1

— Using the Repair option

— Using the Remove option

• Sections:

— Administrator choices during upgrade

— Effects of upgrade

• Table:

— Target machine condition related to operation performed by installation
software

June 2007 Standard 01.02. This document is up-issued to reflect changes in technical
content in the following section:
Section: Remove

May 2007 Standard 01.01. This document is issued to support Communication Server
1000 Release 5.0. This document contains information previously contained
in the following legacy document now retired: Common Network Directory
(NN-10300-028). No new content has been added for Communication Server
1000 Release 5.0. All references to Communication Server 1000 Release 4.5
are applicable to Communication Server 1000 Release 5.0.

March 2006 Standard 2.00. This document is up-issued to support Telephony Manager 3.0.

February 2005 Standard 1.00. This document was first released for the ESM CND 1.0 product
as version 1.01.0 for controlled release.
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Introduction

Contents
This section contains the following topics:

• "Introduction" (page 17)

• "CND Manager" (page 17)

• "CND Manager distribution media" (page 18)

• "Tools" (page 18)

Introduction
Common Network Directory (CND) is a Lightweight Directory Access
Protocol (LDAP) Version 3 compliant directory server with extended schema
and functionality to support Nortel applications. Applications, such as Nortel
Communication Server 1000 Telephony Manager (TM) currently use CND
as a shared repository of subscriber data.

CND consists of two main components:

• the LDAP Version 3 compliant directory server with standard and Nortel
proprietary schema

• a graphical management utility called CND Manager, to manage
selected aspects of the directory server

CND Manager
Administrators can use CND Manager to configure CND. The following
aspects of the CND service are configurable:

• query processing limits: the maximum size and time limits for queries

— For more information about Query processing limits see "Query
processing limits" (page 44).

• debug log settings: options for debug logging

— For more information about Debug log settings see "Logging" (page
46).
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18 Introduction

• Transaction Layer Security/Secure Socket Layer (TLS/SSL) certificate
configuration

— For more information about TLS/SSL certificates see "Clearing
Configuration of TLS Certificates" (page 151).

• port configuration: set the server to listen on the unencrypted port, or
both the unencrypted and encrypted ports

— For more information about Port configuration see "Enabled ports"
(page 50).

• Account Management: add, delete and manage CND application
accounts

— For more information about account management see "Application
accounts" (page 52).

• access control configuration: configure the account access to CND data

• CND passwords: CND Manager ensures that passwords conform to a
set of rules.

— For more information about CND password rules, see "CND
Manager password rules" (page 40).

CND Manager distribution media
CND is distributed as a sub-component of the Nortel applications that
depend on it, such as Telephony Manager and Subscriber Manager. The
CND software is found in a top-level folder on the media used to install these
applications. Usually the folder is named "Common Network Directory" or
"CND". All references to the CND installation media in procedures in this
guide assume this folder as a starting point.

Tools
CND Manager provides a number of useful tools:

• Backup, Scheduled Backup, and Restore: Used to backup and restore
CND data and certain configurations. It is also useful for migrating
data from one CND to another. The Scheduled Backup allows you to
schedule a backup of CND that occurs automatically at some point in
the future.

— For more information about Backup, Scheduled Backup, and Restore
see "Backup, Scheduled Backup, and Restore" (page 61).

• LDAP subscriber synchronization: Supports importing and regular
updates between CND and a corporate directory server
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— For more information about LDAP subscriber synchronization see
"LDAP Subscriber Synchronization" (page 75).

• CSV subscriber export: Exports subscribers from CND into a CSV file

— For more information about CSV subscriber export, see "CSV
Subscriber Export" (page 139).

• Comma Separated Values (CSV) subscriber synchronization: Imports
new subscribers and updates existing subscribers in CND using a CSV
file

— For more information about CSV subscriber synchronization, see
"CSV Subscriber Synchronization" (page 103)

• CallPilot global address book synchronization: provides a central
address book for CallPilot mailboxes by synchronizing CND with the
CallPilot network

— For more information about CallPilot global address
book synchronization see "CallPilot Global Address Book
Synchronization" (page 117).

• Schema Upgrade: allows upgrading of the Nortel schema as new
versions become available

— For more information about Schema upgrade see "Nortel Schema
Upgrade" (page 145)
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System requirements

Contents
This section contains the following topics:

• "Introduction" (page 21)

• "Stand-alone PC requirements" (page 21)

• "Java Runtime Environment (JRE)" (page 22)

• "Co-residency supported" (page 22)

Introduction
Common Network Directory (CND) can co-reside with other Nortel
applications such as the Nortel Communication Server 1000 Telephony
Manager (TM), or it can be installed stand-alone on a PC that does not
have any other Nortel applications installed. When co-residing with other
Nortel applications, the PC requirements are the greater of the application
requirements and CND stand-alone requirements as listed below.

Stand-alone PC requirements
You can install CND on a stand-alone PC, if the PC meets the following
minimum requirements:

• Operating system must be one of the following:

— Microsoft Windows XP (English) with SP2 installed and a locale of
English, French or German

— Windows 2000 Server (English) with SP4 installed and a locale of
English, French or German

— Windows 2000 Server (Japanese) with SP4 installed and a locale
of English

— Windows 2000 Server (simplified Chinese) with SP4 installed and
a locale of English

— Windows Server 2003 with SP1 installed and a locale of English,
French or German
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22 System requirements

— Windows Server 2003 (Japanese) with SP1 installed and a locale
of English

— Windows Server 2003 (Simplified Chinese) with SP1 installed and
a locale of English

• CPU speed: 1 Ghz for Intel-based computers (2 Ghz recommended)

• RAM: 512 MB (1024 MB recommended)

• Disk space: 100 MB for installation (also see Attention note below)

• CD-ROM drive

• Network connectivity

ATTENTION
Extra disk space is required for CND directory data. The amount of disk space
required depends on the amount of directory data.

Java Runtime Environment (JRE)
CND Manager is dependent on Java Runtime Environment (JRE) Version
5.0. CND 2.2 is only supported on a machine that has JRE 5.0 installed.

If JRE 5.0 is not detected you can:

• Install JRE 5.0 during the installation of CND 2.2.

• Run the Sun JRE 5.0 stand-alone installer at a later time. The
standalone installer is available with the CND distribution (see "CND
Manager distribution media" (page 18)). The CND manager does not
run unless the JRE is installed.

Co-residency supported
The only application that CND explicitly supports co-residency with is
Telephony Manager.

CND cannot co-reside on a PC running Microsoft Active Directory, or any
other LDAP directory that uses the standard LDAP ports (389 and 636). A
fresh installation of CND 2.2 cannot be performed if either of these ports
is in use.

Unicode support
CND 2.2 supports characters in the following Unicode code charts:

• Basic Latin

• Latin-1

• Unified CJK Ideographs
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• CJK Ideographs extensions A and B

• Korean

• Hiragana

• Katakana

• Arabic

• Hebrew
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Installation and Maintenance

Contents
This section contains the following topics:

• "Introduction" (page 25)

• "Fresh installation" (page 25)

• "Upgrades" (page 29)

• "Data migration" (page 32)

• "Maintenance mode" (page 32)

Introduction
Use Common Network Directory (CND) 2.2 installation software to perform
the following operations:

• Installing CND 2.2 on a PC or server with no previous version of CND
software. See "Fresh installation" (page 25).

• Upgrading from CND 2.1 to CND 2.2. See "Upgrades" (page 29).

• Data migration from one PC or server to another. See "Data migration"
(page 32).

• Repairing and removing CND 2.2 software after the initial installation.
See "Maintenance mode" (page 32).

Fresh installation
The installation software determines whether CND is already installed and
the version that is installed. Table 1 "Target machine condition related to
operation performed by installation software" (page 25) summarizes the
operation, based on the condition of the target machine.

Table 1
Target machine condition related to operation performed by installation
software

Target machine condition Operation performed

No version of CND is installed Fresh installation
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26 Installation and Maintenance

Target machine condition Operation performed

CND 1.0 is installed No direct upgrade

CND 2.0 is installed No direct upgrade

CND 2.1 is installed Upgrade (see "Upgrades" (page 29))

CND 2.2 is installed Maintenance

CND is shipped as a folder that contains the setup.exe executable file, in
addition to other relevant files and subfolders. You can execute any of
the operations in Table 1 "Target machine condition related to operation
performed by installation software" (page 25) by launching the executable
installation file.

Administrator choices during installation
The administrator must choose the following during the installation of CND
2.2:

• the destination folder for the software files

• administrator account password. See Procedure 1 "Performing a fresh
installation" (page 26), step 6 for more information.

• whether to install Java Runtime Environment (JRE) 5.0

Procedure 1
Performing a fresh installation

Step Action

1 Double-click Setup.exe in the CND distribution media (see "CND
Manager distribution media" (page 18)).

2 When the installation Wizard appears, click Next.

3 Choose the default destination folder for CND.

or

Click Browse to find the destination folder.

4 Click Next.

5 Enter a password for the Administrator account on the CND
Administrator Password screen.

The administrator password is the password used to authenticate
the administrator against the CND server. To prohibit unauthorized
access to the system, any attempt to log on to CND Manager
requires this password.
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The password must comply with the following requirements:

• It cannot be blank.

• It cannot contain spaces.

ATTENTION
For security reasons, Nortel recommends that you do not use the
operating system Administrator password for the CND Administrator
password.

ATTENTION
CND installation software does not encrypt the password. Change
the Administrator password immediately after the first time you log on to
CND Manager to ensure that the password is encrypted. You can change
the Administrator password using the CND Manager Accounts tab.
For details about changing the Administrator password see Procedure
18 "Changing the Administrator account password" (page 57). The
Administrator password is encrypted when changed using CND Manager.
Any CND service configuration changes saved through CND Manager
also cause the administrator password to be encrypted again.

6 Type in the same password in the Confirm Password text box.

The password characters entered are displayed as "*".

7 Click Next to continue with the installation.

CND is installed in the chosen folder.

See Appendix "Destination folder and files" (page 183).

8 Click Next to start the installation.

When the installation status is 100% complete, the JRE installation
window appears (if JRE is not already installed).

9 Click Yes to install JRE 5.0.

or

Click No if you want to install JRE 5.0 later. (Use Procedure 2
"Installing JRE 5.0" (page 29) when you want to install JRE 5.0.)

The JRE 5.0 Installation Wizard launches.

If JRE 5.0 is already installed, the Installation Completed window
appears, displaying the Finish button.

When the JRE 5.0 setup has finished preparing the installation
wizard, the License Agreement window appears.
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10 Click Accept to accept the terms set out in the license agreement.

The Setup Type window appears.

11 Select Typical on the Setup Type window.

12 Click Accept.

The JRE 5.0 Installing progress status window appears.

When the installation of JRE 5.0 is complete, the Installation
Completed window appears.

13 Click Finish.

The InstallShield Wizard window will still be open.

14 Click Finish to close the Install Wizard window.

—End—

Effects of fresh installation
A fresh installation affects the target machine in the following ways:

• files and directories are installed in the chosen destination folder. See
Appendix "Destination folder and files" (page 183).

• items are added to the Start menu.

A Nortel folder is added to the Start menu, if it does not already exist.
Within the Nortel folder, a "Common Network Directory" sub-folder is
created that contains the following items:

— CND Manager

— Clear configuration of CND Manager Transaction Layer Security
(TLS) certificates

— Show CND version

• the CND service is created and started.

The CND service is installed with the name Nortel Common Network
Directory with a startup type of automatic. After installation is
successfully completed, this setup allows the Windows operating system
to start the CND service automatically when the system is rebooted.

Installing Java Runtime Environment (JRE) 5.0
CND 2.2 requires Java Runtime Environment (JRE) 5.0. CND requires that
JRE 5.0 is the system’s default JRE.

CND is shipped as a folder that contains the setup.exe executable file, in
addition to other relevant files and subfolders.
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As the last step in the installation of CND, administrators are asked to install
JRE 5.0, if it is not already installed on the system.

There are two ways to install JRE 5.0 software:

• as part of the installation of CND. See Procedure 1 "Performing a fresh
installation" (page 26).

• separately, after CND 2.2 is installed. See Procedure 2 "Installing JRE
5.0" (page 29).

Procedure 2
Installing JRE 5.0

Step Action

1 Double-click the Sun Java Runtime JRE installer included with the
CND media (see "CND Manager distribution media" (page 18)).

When the JRE 5.0 setup has finished preparing the installation
wizard, the license agreement window appears.

2 Select Typical radio button.

3 Click Accept.

The JRE 5.0 Installing progress status window appears.

When the installation is complete, the Installation Completed window
appears.

4 Click Finish.

5 If directed, reboot the computer after installing JRE 5.0 the first time.

—End—

Upgrades
You can only automatically upgrade to CND 2.2 from CND 2.1. Directly
upgrading from CND releases prior to CND 2.1 is not supported. If you
attempt to upgrade to CND 2.2 from a release prior to CND 2.1 (for
example, CND 2.0), the system prohibits the upgrade and displays an error
dialog that states, "You cannot directly upgrade from Nortel CND 2.0 to
CND 2.2. Consult the Administration Guide for upgrade and data migration
instructions."

To upgrade from releases prior to CND 2.1 perform one of the following
upgrade procedures:

• Procedure 3 "Upgrading from a release prior to CND 2.1 without data
migration" (page 30)
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• Procedure 4 "Upgrading from a release prior to CND 2.1 with data
migration" (page 31)

CND 2.2 installation software is packaged as one executable file. You
can run the upgrade operation as indicated in Table 1 "Target machine
condition related to operation performed by installation software" (page
25) by launching the executable installation file.

Administrator choices during upgrade
CND is shipped as a folder that contains the setup.exe executable file, in
addition to other relevant files and subfolders. If CND 2.2 is installed on a
PC that does not have any version of JRE 5.0 installed, you have the option
of installing JRE 5.0 during the upgrade or waiting until another time.

If you decide not to install JRE 5.0 during the upgrade to CND 2.2, you can
run the JRE 5.0 installer included on the CND 2.2 deployment CD. See
Procedure 2 "Installing JRE 5.0" (page 29) for instructions.

ATTENTION
Back up CND data before you start the upgrade.

Backup files are not removed if they are stored in the default location.

ATTENTION
To install files during an upgrade, the CND service is stopped. However, stopping
the service impacts potential clients of CND. Therefore, you can choose to cancel
and run the upgrade later, rather than stopping the service at that time. The CND
service is automatically restarted after an upgrade.

If you choose to cancel an upgrade, the system prompts you to confirm your
decision to cancel. If you confirm, the system returns to its state prior to the
start of the upgrade.

Procedure 3
Upgrading from a release prior to CND 2.1 without data migration

Step Action

1 Remove the current version of CND (see "Remove" (page 34)).

2 Perform a fresh installation of CND 2.2 (see Procedure 1 "Performing
a fresh installation" (page 26)).

—End—
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Procedure 4
Upgrading from a release prior to CND 2.1 with data migration

Step Action

1 Logon to CND Manager application (see Procedure 9 "Launching
CND Manager" (page 42)).

2 Back up data to a file.

3 Remove the current version of CND (see "Remove" (page 34)).

4 Perform a fresh installation of CND 2.2 (see Procedure 1 "Performing
a fresh installation" (page 26)).

5 Logon to CND Manager (see step 1 in this procedure).

6 Restore from the backup file created in step 2 (see "Restore" (page
71)).

—End—

Effects of upgrade
An upgrade affects the target machine in the following ways:

• Files and directories are installed or overwritten into the destination
folder chosen during the installation of an earlier version of CND. See
Appendix "Destination folder and files" (page 183).

• Start menu items are modified—An upgrade deletes the Start menu
folder and items that were created during the installation of an earlier
version of CND and recreates the Start menu items as if a fresh
installation had occurred. See "Effects of fresh installation" (page 28).

• The CND service is restarted and has some of its properties changed.

You are not asked to choose a destination folder during an upgrade.
Files are installed into the destination folder that was chosen during
the installation of CND. The files and subdirectories within the chosen
destination directory are the same after an upgrade as after a fresh
installation. See Appendix "Destination folder and files" (page 183).

An upgrade to CND 2.2 changes the CND service as follows:

• the service is configured to automatically start every time the machine
restarts

• the service name is changed to "Nortel Common Network Directory"

• the service is given a description in the Description column of the
Services window
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Data migration
You can restore backup files to CND 2.2 created in:

• CND 1.0

• CND 2.0

• CND 2.1

• CND 2.2

You can not restore backup files created in CND 2.2 to any previous release
of CND.

To migrate CND 2.2 data installed on system A to system B, perform the
steps in Procedure 5 "Migrating CND data from one system to another"
(page 32).

Procedure 5
Migrating CND data from one system to another

Step Action

1 On system A, launch CND Manager.

See Procedure 9 "Launching CND Manager" (page 42).

2 Back up data to a file (for example, systemAData.bak).
See "Manual backup using CND Manager" (page 63).

3 Copy the systemAData.bak file to system B.

4 If CND 2.2 is installed on system B, go to step 5.

or

Install CND 2.2 if it is not installed on system B (see Procedure 1
"Performing a fresh installation" (page 26)).

5 On system B, launch CND Manager:

From the Start menu select Nortel > Common Network Directory
> CND Manager (see "Launching CND Manager" (page 41)).

6 Restore data from systemAData.bak.
See Procedure 24 "Performing a restore" (page 72).

—End—

Maintenance mode
The CND 2.2 installation application runs in maintenance mode if CND
2.2 is already installed.
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CND 2.2 installation software is packaged as one executable file. You can
run the maintenance operation in Table 1 "Target machine condition related
to operation performed by installation software" (page 25) by launching
the executable installation file or by launching the Add/Remove Programs
application from the system Control Panel.

In maintenance mode , CND 2.2 installation offers the following options:

• Repair – Reinstalls all program components installed by the original
installation.

• Remove – Completely uninstalls CND from the system.

These options are shown in Figure 1 "Installation: Maintenance mode"
(page 33).

Figure 1
Installation: Maintenance mode

ATTENTION
The Modify option is reserved for future use.

Repair
Repair reinstalls CND 2.2 folders and files. You can repair a corrupted file
or a file deleted by mistake.

Note that the following are not overwritten during a repair:

• CND data
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• CND Manager and LDAP Subscriber Synchronization log files

• the files that store CND service configuration parameters

Procedure 6
Using the Repair option

Step Action

1 Go to Start > Control Panel > Add/Remove Programs.

2 Select Nortel Common Network Directory in the list of programs.

3 Click Change/Remove.

The window shown in Figure 1 "Installation: Maintenance mode"
(page 33) appears.

4 Select the Repair radio button.

5 Click Next.

A Question window appears, asking if you still want to proceed.

6 Click Yes to proceed.

The Maintenance Complete screen appears.

ATTENTION
A window may appear asking for the location of the Setup.ini file. If this should
happen, follow these steps:

• Click Browse to find the location of the CND install software.

• Click OK.

7 Click Finish.

—End—

See Appendix "Destination folder and files" (page 183) for more information
about the files that are overwritten.

Remove
The Remove option deletes the current version of CND from a system.

Note that the following are not removed when CND is removed:

• TLS certificates

• backup files stored in CND’s default location
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• JRE 5.0

You must ensure that CND Manager is not running before starting the
following procedure.

Procedure 7
Using the Remove option

Step Action

ATTENTION
The following steps may vary slightly, depending on which version of Windows OS
you are running.

1 Go to Start > Control Panel > Add/Remove programs .

The Welcome dialog appears as shown in Figure 1 "Installation:
Maintenance mode" (page 33)

2 Click Change/Remove to remove CND 2.2.

3 Click Next.

The confirmation request dialog appears, stating "Uninstall will
remove the directory service, CND Manager, and all directory data.
Do you want to continue?".

4 Click Yes.

The cursor changes to an hourglass during the removal process.
The Maintenance Complete screen appears.

5 Click Finish.

—End—

Removing JRE 5.0
Once installed, JRE 5.0 can be used by other applications. Therefore, if
JRE 5.0 was installed during the installation of CND 2.2, it is not removed if
CND 2.2 is removed.

JRE 5.0 can be removed through Add/Remove Programs in the Windows
Control Panel if you are certain that it is not required by other applications.
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CND Manager

Contents
This section contains the following topics:

• "Introduction" (page 37)

• "Launching CND Manager" (page 41)

• "User interface" (page 38)

• "Management functions" (page 43)

Introduction
Common Network Directory (CND) Manager is the configuration and
management utility for the CND. CND Manager is a user-friendly,
Windows-based application that allows administrators to manage the server
and run tools.

CND Manager manages the following aspects of CND:

• CND service configuration

• Server security

• CND accounts

CND Manager tools provide the following capabilities:

• Backup, Scheduled Backup, and Restore

• Lightweight Directory Access Protocol (LDAP) Subscriber
Synchronization

• Comma Separated Values (CSV) Subscriber Export

• CSV Subscriber Synchronization

• CallPilot Global Address Book Synchronization

• Nortel Schema Upgrade
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User interface
The CND Manager is comprised of two main sections:

• CND Menu items (see "Menu items" (page 38))

• CND Management functions (see "Management functions" (page 38)

The CND Manager window is shown in Figure 3 "CND Manager window"
(page 43).

Menu items
The CND Menu items are used to help you complete or navigate to specific
tasks. There are three menu items on the CND manager. They are:

• File – The file menu has a single submenu item, Exit, which is used to
save and close the CND manager.

• Tools – The tools menu allows you to access various tools to manage
the directory, such as backing up and restoring the directory, subscriber
synchronization, exporting of subscriber data, and upgrading the
schema. The submenu items are:

— Backup

— Restore

— Subscriber synchronization, which includes:

– LDAP subscriber synchronization

– CSV subscriber synchronization

– CallPilot Global Address Book synchronization

— CSV subscriber export

— Nortel schema upgrade

• Help – You can access the CND Administration Guide or get information
about the release of the CND from the help menu. The submenu items
are CND Administration Guide, which launches the Administration Guide
and About CND Manager, which displays an information window about
CND and its version. For more information, see "Version Information"
(page 149).

Management functions
The management functions are used to configure the CND Parameters.
There are three Management functions:

• Service Configuration—The Service Configuration tab is used to
configure the CND service query processing limits and logging settings.
It is also used to view, save and clear logs. See "Management functions"
(page 43).
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• Privacy Settings—The Privacy Settings tab is used to configure transport
encryption for traffic between a client and CND using Transport Level
Security/Secure Sockets Layer (TLS/SSL) technology. See "Privacy
Settings tab" (page 48).

• Accounts Management—The Accounts Management tab is used by
administrators to manage CND accounts and to configure their access
to CND data. Cients who want to access the data in CND are required
to first inform the service of their identity. CND then compares this
information with a list of internally-configured accounts. Once CND
has established an account to use for a given client session, access
permissions are applied to that session according to the current
configuration. See "Accounts Management tab" (page 51)

ATTENTION
Whenever changes are made to the CND Manager configuration, a service restart
is required for those configuration changes to take effect.

Close the CND Manager to save any changes you have made. You are
prompted to perform a service restart.

Use Procedure 8 "Closing CND Manager with a service restart" (page 39) to
apply your changes in CND Manager. The service restart is required in
order to apply the changes.

Procedure 8
Closing CND Manager with a service restart

Step Action

1 Click OK from the CND manager window.

or

Select File > Exit in the CND Manager window.

The Restart CND Service dialog appears.

2 Click Yes to restart the CND service immediately.

or

Click No to restart the CND service at a later time.

If you select "Yes", a restart dialog box appears indicating the status
of the CND service restart. If you select "No" a warning message
appears notifying you that changes are not applied to the CND
service until it is restarted.

3 Click OK to close the dialog box.

The CND Manager window closes.
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—End—

If you choose to restart the CND service later you are required to manually
restart the CND service. For details on manually starting the CND services
see Procedure 47 "Starting the CND Service manually" (page 153).

CND Manager password rules
In Common Network Directory (CND) 2.2, CND Manager ensures that
passwords conform to certain rules. For details on the password rules, see
"Password rules" (page 40). For details on when the password rules are
enforced, see "When password rules are enforced" (page 41).

Password rules
CND Manager ensures that passwords conform to all of the following rules:

• They must have at least 8 characters.

• They must not have a space.

• They must have at least one uppercase letter.

• They must have at least one lowercase letter.

• They must have at least one punctuation character.

• They must have at least one digit.

Definition of letter, punctuation, and digit
CND Manager uses Unicode general categories to identify an uppercase
letter, lowercase letter, punctuation character, and digit. For example, É is
considered an uppercase letter and ô is considered a lowercase letter. In
particular, letters are not restricted to the English letters from A to Z.

Examples:

CND Manager does not allow any of the following passwords:

Table 2
Examples of disallowed passwords

Password Explanation of why password is not allowed

He2You! Password is too short – it is only 7 characters.

Hello 2You! Password has a space.

hello2you! Password does not have an uppercase letter.

HELLO2YOU! Password does not have a lowercase letter.
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Hello2You Password does not have a punctuation character.

HelloYou! Password does not have a digit.

CND Manager allows both of the following passwords:

• Hello2You!

• ÉÉÉ&8ôôô

The second password is allowed because É is considered an uppercase
letter and ô is considered a lowercase letter.

When password rules are enforced
The password rules are only enforced in the following cases:

• When an application account is added using CND Manager.

• When an application account’s password is changed using CND
Manager.

• When the CND Administrator’s password is changed using CND
Manager.

When password rules are violated
When you attempt to use CND Manager to add or change a password that
violates one or more of the password rules, the Password Error dialog
screen appears.

Launching CND Manager
To prohibit unauthorized access to the system, administrators are required
to log on to CND Manager. Only the Administrator of CND is permitted
access to CND Manager.

When CND Manager is started, the administrator is asked to log on.
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ATTENTION
Running multiple instances of CND Manager is not supported.

Multiple instances of CND Manager can be detected if the following situations
occur:

• there is another instance of CND Manager running

• the operating system was not shut down properly (for example, due
to a power failure)

• CND Manager was not shut down properly

If you try to launch CND Manager while another instance of CND Manager is
detected as running on the same computer, you receive the warning message
that another instance of CND Manager has been detected on your computer.

If you are sure that no other instances of CND Manager are running on this
computer, click OK to continue. If any other instance of CND Manager is running
on this computer, click Cancel to exit.

Procedure 9
Launching CND Manager

Step Action

1 From the Start menu select All Programs > Nortel > Common
Network Directory > CND Manager, or click the CND Manager
desktop shortcut.

Figure 2
Launching CND Manager

The CND Manager Login window appears.
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2 Enter the CND Administrator password.

The password entered here is the same one used during installation
(see Procedure 1 "Performing a fresh installation" (page 26).

3 Click OK to log on.

If your logon succeeds, CND Manager launches. See Figure 3 "CND
Manager window" (page 43).

Figure 3
CND Manager window

If your logon fails, Login Failed warning dialog appears.

Check your password. If you are using the correct password, you
may need to clear the TLS certificate configuration. See "Clearing
Configuration of TLS Certificates" (page 151).

—End—

Management functions
Service configuration tab

Use the Service Configuration tab to configure the CND service query
processing limits and logging settings. See Figure 4 "Common Network
Directory Manager: Service configuration tab" (page 44).
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Figure 4
Common Network Directory Manager: Service configuration tab

Query processing limits
The query processing limits include size and time limits:

Size limit – The size limit defines the maximum number of records that can
be returned as the result of a single query to the directory. By default the
size limit is unlimited.

Procedure 10
Setting a size limit on the number of records to return

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Service Configuration tab.

3 Click Edit located to the right of Size Limit (entries):.

The Query size limit configuration dialog appears.

4 Select Unlimited (default) to assign an unlimited size limit for query
processing.

or
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Select Limited to assign a limited size limit for query processing,
and enter the size limit for query processing in the text field.

5 Click OK.

6 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

—End—

Time limit – The time limit defines the maximum time the CND service waits
for query results before issuing a query processing timeout. The unit of time
that is being configured is seconds. By default the time limit is unlimited.

Procedure 11
Setting a time limit on the query

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Service Configuration tab.

3 Click Edit located to the right of Time Limit (seconds):.

The Query time limit configuration dialog appears.

4 Select Unlimited (default) to assign an unlimited time limit for query
response.

or

Select Limited to assign a specific time limit for query response, and
enter the time limit for query response in the text field.

5 Click OK.

6 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

ATTENTION
The Administrator account is not subject to the query processing limits.
The Administrator account always has unlimited query processing
privileges. The query processing limits, as assigned by the administrator,
are applicable to all other accounts, including all application accounts.
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—End—

Logging
CND Manager allows you to configure OpenLDAP logging options. See the
Open LDAP 2.2 Administrators Guide (http://www.openldap.org/) for more
information about these OpenLDAP logging options.

Logging is used to log messages generated by the CND service. By default,
logging of the CND service is not enabled.

Logging options are configured using the "Logging Settings" that appear
in the Service Configuration tab.

You can select none, or one or more of the following OpenLDAP service
logging options:

• trace function calls

• debug packet handling

• heavy trace debugging

• connection management

• print out packets sent and received

• search filter processing

• configuration file processing

• access control list processing

• stats log: connections/operations/results

• stats log: entries sent

• print communications with shell backends

• print entry parsing debugging

All the information is stored in one log file.

Logging records information, based on the categories listed above is a
good tool for troubleshooting.

Procedure 12
Configuring OpenLDAP service logging options

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Service Configuration tab.
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3 Enable the log messages you wish to have generated under the
Logging Settings section by placing a check mark next to the log
type.

4 Click OK.

5 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

—End—

ATTENTION
Stopping and restarting the CND service regenerates the service log file. The old
log file is overwritten.

ATTENTION
Logging options slow down the performance of the CND service. With each
additional enabled logging option, CND service performance is further degraded.

Viewing log

Procedure 13
Viewing the CND service log

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Service Configuration tab.

3 Click the View Log button.

The information in the log depends on the logging options that are
configured.

—End—

Saving and clearing log If the CND service is running for long periods
and many logging options are selected, it is recommended that you clear
the log file occasionally. You can back up the log file using the "Clear Log"
option and save the old log file to a desired location.
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Procedure 14
Saving and clearing log

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Service Configuration tab.

3 Click Clear Log.

The Select an Option dialog appears.

4 Select one of the following three options:

• Click Cancel to cancel the clear log operation and go to Step 8.

• Click No if you don’t want to save the current logs to a backup
file and go to Step 8.

• Click Yes if you would like to backup the log files before clearing
the log.

The Save file window appears.

5 Browse to the location where you wish to save the file.

6 Type the log file name in the File name field.

7 Click Save.

8 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

—End—

Privacy Settings tab
Network traffic between CND and a client can be encrypted using Transport
Level Security/Secure Sockets Layer (TLS/SSL) technology.

Use the Privacy Settings tab to:

• set up the server encryption certificates

• assign the enabled CND ports

See Figure 5 "Privacy settings tab" (page 49).

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



Management functions 49

Figure 5
Privacy settings tab

Installing certificate files on the server
For the Secure Socket Layer (SSL) transport to be fully operational the
appropriate files must be installed in CND. You can obtain a service
certificate from a trusted authority (for example, Verisign) or generate a
certificate using a certificate server.

This document assumes you have already obtained a server certificate
and key file, and only describes the steps required to install them. Using
the Privacy Settings tab, install the required certificates and key file on the
CND server.

Server certificates and key files
The server certificates must be issued by the same Certificate Authority
(CA) that issued the CA certificate. In addition, the key file must be the one
that was used to generate the server certificate.

If you select an invalid certificate, the CND service fails to start. If this
happens, see "Clearing Configuration of TLS Certificates" (page 151).
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Enabled ports
Privacy settings allow you to configure communications between SSL
clients and non-SSL clients and the CND server. These settings allow you
to choose whether the CND service listens on the unencrypted port only
or listens on both the encrypted and the unencrypted port. By default, the
service listens only on the unencrypted port. To configure CND to listen on
both ports, follow Procedure 15 "Enabling the encrypted port" (page 50).

Procedure 15
Enabling the encrypted port

Step Action

1 Copy the server certificates that you obtained prior to beginning this
section to the "certs" subfolder under the CND installation folder.

2 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

Depending on how you obtained the certificate information, there
may only be one file that contains the certificates and the key. Select
that file name for each of the lists described in step 4.

3 Select Privacy settings tab.

4 Select the Server Certificate from the list.

5 Select the Key file from the list.

6 Select the CA certificate from the list.

7 Select the Listen on both encrypted and unencrypted port option
in the Enabled Ports section of the screen.

The options in the Enabled Ports section remain disabled until you
have completed Steps 5 to 7.

8 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

If the CND service does not start you can clear the TLS
configurations. For more information on clearing Configuration of
TLS certificates see "Clearing Configuration of TLS Certificates"
(page 151).

—End—
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Accounts Management tab
Clients who want to access the data in CND are required to first inform the
service of their identity. CND then compares this information with a list of
internally-configured accounts. Once CND has established an account
to use for a given client session, access permissions are applied to that
session according to the current configuration.

The Accounts Management tab to is used by administrators to manage
CND accounts and to configure their access to CND data.

Figure 6
Accounts management tab

There are two types of accounts in CND:

• System accounts

• Application accounts

The following sections describe these account types and the rules for
working with them.

System accounts
There are three CND system accounts:

• Administrator account – This is the most powerful account in CND.
There is only one Administrator account. The account cannot be deleted
and additional Administrator accounts cannot be created. The only
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operation permitted on the Administrator account is a password change.
Access control permissions for the Administrator are to always allow
full write access to all data in CND. These access permissions cannot
be changed.

• Anonymous account – This is the account used by all
non-authenticated sessions with CND. The Anonymous account cannot
be deleted and additional Anonymous accounts cannot be created.
Since the account is used unauthenticated, there is no password to
change. Default access permissions (as shown in Table 4 "Default
access levels" (page 53)) are applied to the Anonymous account, but
they can be changed. See "Modifying access level" (page 59).

• Default account – Like the Anonymous account, there is only one
Default account with no password attribute. Additional Default accounts
cannot be created. The Default account is used to hold the access rights
for any authenticated user who does not have explicit access permission
settings for a given object in CND. Default access permissions (as
shown in Table 4 "Default access levels" (page 53)) are applied to the
Default account, but they can be changed. See "Modifying access level"
(page 59).

Application accounts
Application accounts are used by applications to access data in CND.
They can be installed manually using the Accounts Management tab. CND
2.2 has four predefined application accounts (see Table 3 "Predefined
application accounts" (page 52)):

Table 3
Predefined application accounts

Account
Name

Description Default
Password

TM This account is used by the Nortel Communication
Server 1000 Telephony Manager (TM).

tmpass

ESM This account is used by the Enterprise Subscriber
Manager (ESM).

odyssey

Messaging This account is used by CallPilot applications. cppass

SubMgr This account is used by the Subscriber Manager
application.

submgrpass

Table 4 "Default access levels" (page 53) shows you the default access
levels for these accounts.

Organizational units
For information about domain components, see "Organizational Unit (ou)"
(page 167).
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Domain components
For information about domain components, see "Domain Component (dc)"
(page 167).

Access Levels
For each account in CND, access permissions can be defined for each
organizational unit. If a given account does not have explicit permissions
defined for one of the organizational units, any client logged in as that
account receives the permissions of the Default account.

There are three possible levels of permissions, referred to as access levels,
which can be applied:

• Read – accounts with this access level for a given organizational unit
are permitted to read its data but not to add new objects or modify
existing objects

• Write – accounts with this access level are permitted to read, add and
modify the data in the given organizational unit

• None – accounts with this access level for a given organizational unit
are restricted from accessing any of its data

Table 4
Default access levels

Account Access to ou=Subscribers,d
c=Nortel,dc=com

Access to ou=Applications,d
c=Nortel,dc=com

Administrator Write Write

Anonymous Read Read

Default Read Read

Application
Accounts

Write Read

Managing accounts

ATTENTION
CND supports up to 100 application accounts.

The operations you can perform on application accounts are listed below:

• Add new account

• Change Password

• Delete account

• Modify access level
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The following sections detail the procedures you use to perform these
operations.

Procedure 16
Adding an application account

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select the Accounts Management tab.

3 Right-click the Applications folder in the CND Accounts tree.

Figure 7
Create new account

4 Select the New account option from the context menu.

The Add Account window appears.

In the Add Account window enter the Account Name in the text
field.

The following rule applies to all Account Names:

• They cannot be blank.
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5 Enter the password for the new account in the Password field. See
"Password rules" (page 40).

6 Enter the password again in the Confirm field.

7 Click OK to create the new account and close the Add Account
window.

or

Click Cancel to cancel the addition and close the Add Account
window.

8 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39).

—End—

Application account password change

ATTENTION
Changing application accounts can cause service interruptions for the applications
affected. Coordinate an account configuration change in the application when
modifying the CND account. Notifications are not sent to applications in the event
of a CND application account change.

To change an existing application account password, see Procedure 17
"Changing an existing application account password" (page 55).

Procedure 17
Changing an existing application account password

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Accounts Management tab on CND Manager.

3 Expand the Applications folder.

4 Select the existing application account for which you wish to change
the password. (The account is highlighted.)

5 Right-click the highlighted application account.

A menu appears with two options:

• Change password...
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• Delete account

6 Select the Change password... option from the context menu as
shown in Figure 8 "Change password" (page 56).

The Change Password dialog appears.

Figure 8
Change password

7 Enter the old password in the Old Password field.

8 Enter the new password for the Application account in the New
Password field.

The new password must conform to the password rules and
restrictions. See "CND Manager password rules" (page 40).

9 Enter the new password in the Confirm field.

10 Click OK to save the changed application account password and
close the Change Password dialog.

or

Click Cancel to cancel the task and close the Change Password
dialog.

11 Close CND Manager to save and activate the changes immediately.
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—End—

Administrator account password change To change the Administrator
account password, see Procedure 18 "Changing the Administrator account
password" (page 57).

Procedure 18
Changing the Administrator account password

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Accounts Management tab on CND Manager.

3 Expand the CND Accounts folder.

4 Select Administrator.

5 Right-click the Administrator account. (The account is highlighted.)

6 Select the Change password option from the context menu, as
shown in Figure 8 "Change password" (page 56).

The Change Password dialog appears. See .

7 Enter the old password in the Old Password field.

8 Enter the new password for the Administrator account in the New
Password field.

The new password must conform to the password rules and
restrictions. See "CND Manager password rules" (page 40).

9 Enter the new password in the Confirm field.

10 Click OK to save the Administrator account password and close
the Change Password dialog.

or

Click Cancel to cancel the task and close the Change Password
dialog.

11 Close CND Manager to save and activate the changes immediately.

—End—
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Deleting an existing application account

ATTENTION
If an application account is deleted from CND Manager, that application can
no longer communicate with the directory and can no longer store data in the
directory.

Procedure 19
Deleting an existing application account

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Accounts Management tab on CND Manager.

3 Expand the Applications folder.

4 Select the Application account you wish to delete.

5 Right-click the existing application account.

6 Select the Delete account option from the context menu as shown
in Figure 9 "Delete account" (page 58).

Figure 9
Delete account
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The Confirm Delete dialog appears.

7 Click Yes to confirm the delete task.

or

Click No to cancel the delete task.

8 Close CND Manager to save and activate the changes immediately.

—End—

Modifying access level
Access level modifications are permitted for Anonymous, Default, and
application accounts, not for the Administrator account.

ATTENTION
The access level of the Administrator account cannot be modified. Modifying
access permissions for the application, Anonymous, and Default accounts
can result in reduced security. Consider such modifications carefully prior to
implementation.

Procedure 20
Modifying access level

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Accounts Management tab on CND Manager.

3 Expand the Applications folder.

4 Select the Application Account for which you wish modify access
levels.

The Organizational Unit and Access Level for the selected
application are displayed in the right-hand side of the screen (see
Figure 10 "Select access level" (page 60)).

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



60 CND Manager

Figure 10
Select access level

5 Select the Access Level field next to the organizational unit you
want to change.

6 Change the Access Level.

7 Close CND Manager to save and activate the changes immediately.
See Procedure 8 "Closing CND Manager with a service restart"
(page 39)).

—End—
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Backup, Scheduled Backup, and
Restore

Contents
This section contains the following topics:

• "Introduction" (page 61)

• "Manual backup using CND Manager" (page 63)

• "Manual backup using CND Manager" (page 63)

• "Manual backup using Command Line Interface" (page 64)

• "Scheduling automated backups" (page 66)

• "Error handling" (page 71)

• "Restore" (page 71)

Introduction
The data contained in Common Network Directory (CND) is critical to the
day-to-day operation of the business. This data can be damaged for various
reasons, such as disk failure, operator error, theft or disasters.

CND data can be backed up and restored using the Backup and Restore
options in the Tools menu in CND Manager.

Administrators can schedule a backup of CND data by using the Windows
scheduler to schedule the execution of a DOS batch file that is deployed
with CND. The DOS batch file can also be run manually from the DOS
command prompt.

The Restore tool helps recover the system from a previous backup.

The Backup, Scheduled Backup, and Restore tools require a service restart.
Therefore, it is recommended that you use these tools during off-peak hours.
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The data backup requires sufficient physical drive space to carry out the
operation. The amount of disk space required depends on the amount of
data stored in CND.

Backup
The Backup tool is used to create a backup of the CND server content. The
destination directory can be on the local drive or on the network drive where
the administrator has write permission.

There are three ways to back up the data on the CND, two of the methods
are manual and the third is an automated backup. The difference between
the two manual methods is the level of detail you can specify when running
the backup operation.

1. manual backup method one—Use the tools menu in the CND Manager
(see Procedure 21 "Performing a backup from CND Manager" (page
63)). If you perform a backup using this procedure, you must manually
name the file and select the location of the backup file.

2. manual backup method two—Run a backup script from the Command
Line Interface (see Procedure 22 "Performing a backup from Command
Line Interface (CLI)" (page 66). The script allows you to specify three
different options:

• folder—The folder option permits you to specify the location where
the backup files are saved.

• prefix—The prefix option allows you to specify what prefix you would
like included in the file name. When the backup file is created, the
beginning of the file name created will include the prefix you choose.

• IP—When the IP option is selected, the IP address of the server that
is being backed up is appended to the file name. When any file is
created using the script method, the file name will automatically
include the date and time of creation. This is very helpful, as it
enables you to identify when the backup file was created.

Understanding these manual options is required in order to make good
use of the third backup method, which is to automate the backup.

3. automated backup method—The automated backup will execute the
script used in the second manual procedure at a predefined time that
you establish (see Procedure 23 "Scheduling a backup of CND data"
(page 68)) .

The automated scheduling of CND backup is achieved using the
Windows scheduler to schedule the execution of a DOS batch file that is
deployed with CND.
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Manual backup using CND Manager
The default backup file name is in the format: current year, current month,
current day (for example, 20061127CND.bak). The default location is the
"backup" sub-folder in the CND installation directory.

To perform a backup from CND Manager, see Procedure 21 "Performing a
backup from CND Manager" (page 63).

Procedure 21
Performing a backup from CND Manager

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Backup on the Common Network Directory Manager
window.

The Backup window appears (see Figure 11 "Backup window"
(page 63)).

Figure 11
Backup window

3 Navigate to the folder where you want the server to store the backup
file.

4 Enter the backup file name in the File name text box or accept the
default value.

If the backup file already exists a warning message appears, asking
if you want to overwrite the file. Click Yes or No depending on what
you would like to do.
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ATTENTION
The .bak extension is automatically added if files of type Backup files
(*.bak) are selected from the Files of type list.

ATTENTION
Nortel recommends that you use the .bak file extension for backup
files. However, CND supports restoring from files regardless of their file
extension, provided that the file is a valid backup file.

5 Click Backup to start the process.

A warning dialog appears stating, "The CND service must be
temporarily stopped to perform the backup".

6 Click Yes to continue. The backup operation begins and a progress
dialog is displayed.

or

Click No to cancel the backup.

Canceling the backup may result in the necessity to manually restart
the CND service.

ATTENTION
Do not manually start or stop the CND service while a backup is in
progress. During a backup, if any applications that use CND are running,
they fail to operate, and must be restarted.

The dialog box displays a message clearly indicating whether the
backup was a success or a failure.

7 Click OK when the Backup Progress dialog indicates it has
completed the backup.

—End—

Manual backup using Command Line Interface
Output folder

By default, backup files are created in CND’s default backup folder (the
backup folder of CND’s installation folder). However, you can override the
output folder using a command-line option.
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Backup file names
The filename prefix and whether to include the IP address in the filename
are both configurable using command-line options (see "Filename prefix
command-line option" (page 65) and "IP address in filename command-line
option" (page 65)).

The date and time stamp will always be included in the file name, so if you
change the prefix you are simply adding a prefix to the date and time stamp
of the file name. If you add the -ip option, then you are simply appending
the IP address to the date and timestamp of the backup file name.

Batch file usage
The batch file is named backup.bat and is used as follows:

backup.bat [-folder <outputFolder>] [-prefix
<filenamePrefix>] [-ip]

The batch file provides command-line options that configure the following:

• the output folder in which backup files are placed

• the prefix to put before the backup filename

• whether to include the IP address in the backup filename

Output folder command-line option
To change the output folder, use the -folder command-line option.
For example, to have backup files created on a network drive on
192.168.100.125, schedule the execution of the following command:

backup.bat -folder \\192.168.100.125\CND_Backups

Filename prefix command-line option
By default, the tool uses a filename prefix of CND_. To change the
filename prefix, use the -prefix command-line option. For example, to
prefix backup files with "CND_EastRegion", schedule the execution of the
following command:

backup.bat -prefix CND_EastRegion

IP address in filename command-line option
By default, the IP address of the machine that performs the backup is not
included in backup filenames. To include this information, use the -ip
command-line option. For example, suppose the following command is
scheduled to execute on 192.168.100.125 at 10:42 AM on February 19,
2007:

backup.bat -ip
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This command creates a backup file in CND’s default backup folder named
CND_20070219104200_192.168.100.125.bak.

Performing a backup from Command Line Interface (CLI)
To perform a backup from Command Line Interface (CLI), see Procedure 22
"Performing a backup from Command Line Interface (CLI)" (page 66).

Procedure 22
Performing a backup from Command Line Interface (CLI)

Step Action

1 From Windows select Start > Run.

The Run dialog box appears.

2 Enter cmd in the Run dialog box.

3 Click OK.

A DOS window appears.

4 Change the directory to C:\Program Files\Nortel\Common
Network Directory using the CD command.

5 Run the backup script.

The default name is CND_<datetime>.bak.

The <datetime> parameter is filled in with correct date and time by
the system.

For example, if the backup script is executed, a file similar to the
following is created: CND_20071126144547.bak, where the date
and time parameter is November 26, 2007, 14:45:47.

If the backup script is executed using the -ip op-
tion, a file similar to the following is created:
CND_20071126145418_192.167.101.84.bak, where
the ip address is 192.167.101.84.

The default backup folder is C:\Program Files\Nortel\Common
Network Directory\backup\.

—End—

Scheduling automated backups
Administrators can schedule a backup of CND data by using the Windows
scheduler to schedule the execution of a DOS batch file that is deployed
with CND.
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You can schedule a backup of CND data to run per available options (daily,
weekly, monthly, etc.).

You can remove a scheduled backup from the scheduler, thus preventing
its execution.

When a scheduled backup starts, it temporarily stops the CND service,
and any applications using CND must be restarted. Therefore it is best to
schedule the backup during off-peak hours.

If you cancel the automated backup, you will have to manually restart the
CND service.

Output folder
By default, backup files are created in CND’s default backup folder (the
backup folder of CND’s installation folder). However, users can override the
output folder using a command-line option (see "Output folder command-line
option" (page 65)).

Backup file names
Backup files are named using the following information:

• a prefix (by default, CND_)

• a timestamp in the format of YYYYMMDDHHMMSS, where YYYY is the
year, MM is the month, DD is the day, HH is the hour, MM is the minute,
and SS is the second when the backup starts

• optionally, the IP address of the machine on which the backup was
performed (by default, the IP address is not in the filename)

• a suffix of .bak

The filename prefix and whether to include the IP address in the filename
are both configurable using command-line options (see "Filename prefix
command-line option" (page 65) and "IP address in filename command-line
option" (page 65)).

Overwriting backup files
Backup files are never overwritten. If for some reason a backup file with the
chosen name already exists, it is a minor error (see "Minor errors" (page
71)).

Scheduling workflow
Use the Windows scheduler to schedule the execution of the backup.bat
batch file.
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Scheduling a backup of CND data
To schedule a backup of CND data, see Procedure 23 "Scheduling a backup
of CND data" (page 68).

Procedure 23
Scheduling a backup of CND data

Step Action

1 Open the Windows Control Panel from the CND server.

• On Windows XP, select Start > Control Panel.

• On Windows Server 2003, select Start, right-click Control Panel
and select the Open command.

• On Windows 2000 and Windows 2000 Server systems, select
Start > Settings > Control Panel.

2 Double-click Scheduled Tasks shortcut.

The Scheduled Tasks page appears.

3 Double-click Add Scheduled Task.

The Add Scheduled Task wizard appears.

4 Click Next on the wizard introductory screen

5 Select Browse on the program selection screen.

The Select Program to Schedule window appears.

6 Navigate to the folder where the backup.bat file is located.

The default directory is C:\Program Files\Nortel\Common
Network Directory .

7 Select the backup.bat file.

8 Click Open.

9 Provide a name for this task in the text box.

10 Select the frequency to run the backup.bat file by selecting the
radio button next to the frequency.

When my computer starts or When I log on options are not
supported.

11 Click Next.

12 Enter the parameters required for your backup. This step can vary,
depending on the frequency selected in step 10.
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13 Click Next.

14 Enter the user name that has permission to run the batch.bat file.

15 Enter the user password.

16 Confirm the user password.

If the information in steps 14 to 16 is incorrect or not completed, the
backup.bat file does not execute.

17 Click Next.

18 Select the Open advanced properties for this task when I click
Finish option.

19 Click Finish.

20 In the Run text box, enter the directory path of the backup .bat file
in quotation marks and the options you wish to include outside the
quotation marks.

or

Browse to the location of the backup.bat file and select the
backup.bat file and append the option outside the quotation marks.

Example:
Run "C:\Program Files\Nortel\Common Network
Directory\backup.bat" If no options are selected.
or
Run "C:\Program Files\Nortel\Common Network
Directory\backup.bat" <options> if you want to specify
the options.

ATTENTION
The options are case sensitive, so "C:\Program Files\Nor-
tel\Common Network Directory\backup.bat"-IP would
fail to run, but "C:\Program Files\Nortel\Common Network
Directory\backup.bat"-ip would run as expected.
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Figure 12
Backup dialog box

21 Select the Enabled (Scheduled task runs at specified time)
option.

22 Click Apply.

The Set Account Information dialog box appears.

23 Enter the user password in the Password field.

24 Confirm the user password in the Confirm Password field.

25 Click OK to close the password window.

26 Click OK.

—End—
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Error handling
Errors fall into two categories:

• minor errors that you can probably fix (see "Minor errors" (page 71))

• major errors that you probably can’t fix (see "Major errors" (page 71))

Minor errors
backup.bat detects the following minor errors:

• invalid command-line arguments

• backup file already exists

• output folder does not exist

• failure to create backup file

Minor errors are handled in two ways:

• printed to the console

• logged to CND Manager’s log file (in the log subfolder of CND’s
installation folder)

When a scheduled backup is performed, the console is of little use because
there is probably not a person monitoring it.

Major errors
backup.bat detects the following major errors:

• failed to read CND configuration

• failed to open CND configuration

• internal error

Major errors are printed to standard error and may be logged in CND
Manager’s log file. However, they are not necessarily logged because they
sometimes occur before the batch file can write to the log file.

Restore
Prior to instituting a restoration of CND server data, you must perform a
backup of the data.

Restoring the CND server data
The Restore tool is used to restore the CND server data from a previously
created backup file.

ATTENTION
The CND server is unavailable while restoring data from a backup file.
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ATTENTION
Restoring your directory overwrites any existing data.

The Restore utility performs a CND backup before the Restore process
begins to support roll back if the Restore operation fails. As a result, this
procedure requires additional hard drive space.

The Restore tool does the following steps in the sequence shown:

• stops the CND service

• performs a backup of the directory

• restores directory data and configuration

• restarts the CND service

If the CND service fails to start for any reason, the process restores CND
data to the original state it was in when the Restore process began.

Procedure 24
Performing a restore

Step Action

Pre-requisite - Ensure you have previously performed a backup before
beginning this procedure.

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Restore.

The Restore window appears.

3 Browse to your backup directory and select a valid backup file as
shown in Figure 13 "CND server Restore window" (page 73).
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Figure 13
CND server Restore window

4 Click Restore.

A warning appears as shown in Figure 14 "Restore warning" (page
73).

Figure 14
Restore warning

5 Click Yes to stop the CND service so that the Restore process can
begin.

or

Click No to cancel the Restore process.

ATTENTION
Do not manually start or stop the CND service while a restore is in
progress.
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ATTENTION
On successful completion of the Restore operation, the CND service
restarts and a completion message appears.

If the Restore operation fails, the Restore Progress dialog appears,
providing restore failure information, such as the following (for
example), "Failed to restore from 20061207CND.bak".

6 Click OK to close the Restore dialog.

—End—

ATTENTION
The restore feature does not permit a restore to occur that would result in a Nortel
schema downgrade. The Nortel schema version that is part of the backup file
must be equal to or greater than the version that the server is currently using.
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Contents
This section contains the following topics:

• "Introduction" (page 75)

• "Basic LDAP Subscriber Synchronization" (page 76)

• "Advanced LDAP Subscriber Synchronization options" (page 79)

• "LDAP Subscriber Synchronization Job window" (page 80)

• "Advanced Options window" (page 84)

• "Progress monitor window" (page 85)

• "Procedures for LDAP Subscriber Synchronization" (page 88)

• "Scheduling LDAP Subscriber Synchronization jobs" (page 98)

• "Logging" (page 86)

• "Procedures for LDAP Subscriber Synchronization" (page 88)

Introduction
Common Network Directory (CND) provides central storage of common and
shared data for various Enterprise products, such as Nortel Communication
Server 1000 Telephony Manager (TM). Administrators of these products can
synchronize subscriber data between their Lightweight Directory Access
Protocol (LDAP)-enabled corporate directory servers and CND using the
LDAP Subscriber Synchronization feature.

The term synchronization is defined as follows:

The act of coordinating data between a pair of directory servers.

This feature eliminates the need for duplicate data entry, which reduces
administrative and support costs.

The following LDAP-enabled directory servers are supported:

• Active Directory Server 2000/2003

• Microsoft Exchange Server 2000/2003
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• Sun Java System Directory Server 5.2

The Subscriber Synchronization feature supports the following operations:

• Define a new synchronization job

• Save a new synchronization job

• Run a previously defined synchronization job

• Modify an existing synchronization job

• Delete an existing synchronization job

• View the LDAP Subscriber Synchronization summary log

• Schedule a synchronization job to run at some time in the future, either
repetitively or one time only

• Remove a synchronization job from the scheduler

For more information about synchronization jobs, see "Synchronization
jobs" (page 78).

The information in this chapter is presented in the following order:

• Concepts related to Basic and Advanced synchronization are presented
first.

• Procedures related to synchronization are presented second.

Basic LDAP Subscriber Synchronization
Basic LDAP Subscriber Synchronization defines a limited form of
synchronization. The information in this section defines and describes
general terms related to the LDAP Subscriber Synchronization domain.

Basic synchronization refers to the process of synchronizing data between
an external directory server and CND without any advanced options
configured. This means that a basic synchronization only acts upon data
when there is a pre-established link between an entry in the external
directory server and CND.

LDAP servers
The following sections describe the two types of servers that are involved in
a LDAP Subscriber Synchronization job. They are:

• An external directory server

• CND
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External directory server
The external directory server is a directory server, usually a repository of
the customer’s corporate directory, that is used to acquire the master set of
entries from which a synchronization job is based. The server is considered
the source of a synchronization operation even though the synchronization
may be bidirectional in nature. For more information, see "Synchronization
jobs" (page 78).

CND
CND is considered the destination directory server by the LDAP Subscriber
Synchronization feature in all cases.

Terms related to entries
This section defines terms that are related to entries.

Entries and objectclasses
In LDAP, the units of synchronization are called entries. Each entry
represents an object in the directory server. Entries are defined by their
class of information as defined by the schema of the server. In LDAP, these
classes of information are referred to as objectclasses. Objectclasses
define the rules for what constitutes a particular class of information in the
directory server.

Included in these rules is the list of attributes that an entry of a particular
objectclass can contain. Attributes are defined in the schema. The schema
identifies the names of the attributes and the syntax rules to which a value
of the attribute must adhere.

Entry mapping
Entry mapping is the process of establishing a link between an entry in
the external directory server and one in CND. To establish the map, LDAP
Subscriber Synchronization copies the value of a known attribute in the
external directory server entry to a special operational attribute in the CND
entry. The external directory server attribute that is used for this depends on
the type of the external directory server.

The process of entry mapping can occur in a number of different scenarios:

1. During the import of an entry from the external directory server to CND

2. During an entry resolution operation

Master set of entries
The master set of entries, or master set, is the collection of entries that
is acquired as the result of searching the external directory server. The
search is defined by the search parameters configured for the particular
synchronization job.
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Terms related to attributes
This section defines the LDAP Subscriber Synchronization terms related to
attributes. They are:

• Attribute map

• Attribute relations

• Bidirectional synchronization

Attribute map
An attribute map is a set of attribute relations that determines the behavior
of a synchronization job with regards to the copying of data between the
external directory server and CND.

The attribute map is used by LDAP Subscriber Synchronization to determine
the following:

• Which attributes in the external server to ask for in the search

• The correspondence between external server attributes and CND
attributes

• The direction of the synchronization for each attribute

Attribute relations
An attribute relation is a single entry in an attribute map. The attribute
relation consists of an external directory server attribute, a CND attribute
and the direction with which to synchronize the attributes.

Bidirectional synchronization
A bidirectional synchronization refers to the ability to choose, for
each attribute, the direction for which the copying of data occurs in a
synchronization job. The default direction for all attribute mappings is from
the external directory server to CND.

Synchronization jobs
Synchronization job is the name given to the complete set of configuration
parameters required to run a synchronization between an external directory
server and CND. The degree of synchronicity between directory servers
is always in relation to a particular set of rules for determining what it
means for two directory servers to be ’in sync’. In the LDAP Subscriber
Synchronization feature, these rules are packaged as synchronization jobs
which are configured by the administrator of the system. It is possible for
two directory servers to be ’in sync’ according to one synchronization job,
but ’out of sync’ with respect to another.

A synchronization job consists of:

• The connection details of the external directory server
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• The search parameters used to query the external directory server and
acquire a master set of entries

• An attribute map

• Advanced options. For more information, see "Advanced LDAP
Subscriber Synchronization options" (page 79).

Advanced LDAP Subscriber Synchronization options
The following advanced options of LDAP Subscriber Synchronization are
necessary to define the behavior of the system when it encounters an
unmatched entry. An unmatched entry is an entry in the master set that is
not linked, by entry relations, to an entry in CND. The two options for dealing
with the unmatched entries are:

Importing—Using importing, LDAP Subscriber Synchronization adds
unmatched entries to CND. When importing an entry, the values of its
attributes are determined using the following rules:

• All attributes that are explicitly contained in the attribute map are
synchronized to the new CND entry. This occurs regardless of the
direction defined by the individual attribute relations.

• Any attributes that are not defined in the attribute map, but are required
attributes as determined by the CND schema, are synchronized
according to the default attribute map for the external directory server
type.

Entry resolution—Attempts to establish a match, using criteria outside
entry mapping. The process involves first determining a match and then
establishing the entry map between the two entries. The process of
determining a match is based on comparing the values of a user-defined
attribute in the external directory server with a user-defined attribute in
CND. If the values of the two attributes are equal, the entries are considered
a match.

ATTENTION
It is also an option to ignore unmatched entries; this is the defining factor of a
basic synchronization. It is also possible to turn on both entry importing and
entry resolution. In this event, the system attempts to perform a resolution, and
if that fails, it does an import.

There are other advanced options that do not affect synchronization job
behavior. They are:

Security options—The use of Transport Layer Security/Secure Sockets
Layer (TLS/SSL) encryption is optional but is recommended. The LDAP
Subscriber Synchronization feature supports the use of TLS/SSL for the
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encryption of traffic with both the external directory server and CND. For
more information, see Figure 15 "LDAP Subscriber Synchronization job
window" (page 80).

Logging options—LDAP Subscriber Synchronization generates up to three
types of logs every time it runs a synchronization job. These logs are called:

• "Summary log" (page 87)

• "Transaction log" (page 87)

• "Failure log" (page 88)

The logs are in ASCII text format.

For more information, see "Logging" (page 86).

LDAP Subscriber Synchronization Job window
Figure 15 "LDAP Subscriber Synchronization job window" (page 80) shows
you the LDAP Subscriber Synchronization job window. Use this window
to define all the parameters required by the system to perform a
synchronization between an external directory server and CND.

These parameters are divided into the following categories:

• External Directory Server Connection Details

• External Directory Server Connection Details Search Parameters

• Attribute Map

Figure 15
LDAP Subscriber Synchronization job window
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External Directory Server Connection Details parameters
The following parameters describe the external directory server in a
synchronization job:

• Host: the host name, fully qualified domain name (FQDN), or IP address
of the external directory server host PC.

• Bind DN: the distinguished name (DN) of the account used to
authenticate to the external server.

• Password: the password associated with the Bind DN used to
authenticate to the external server.

• Base DN: The DN of the entry in the external directory server to which
to establish the connection. The base DN determines the connection’s
view of the directory tree by defining the subset of entries in the tree
upon which a connection can act. The base DN is also used to identify
the entry for basing searches.

• Server type: The type of external directory server to which CND is
connected. This is used to determine how entry mapping is established
as well as the defaults for attribute relations. The available selections
are:

— Microsoft Active Directory 2000

— Microsoft Active Directory 2003

— Exchange Server 2000

— Exchange Server 2003

— Sun Java System Directory Server 5.2

The default selection for this parameter is Microsoft Active Directory
2003.

• Port: The port number that the external directory server is listening on.
The standard LDAP ports are 389 for non-encrypted traffic and 636 for
encrypted traffic. The default for this field is 389.

External Directory Server Connection Details Search Parameters
The following parameters configure the query that the LDAP Subscriber
Synchronization utility uses to extract a set of entries from the external
server.

• Search Scope: selected to determine the depth of the search. The
available options are:

— Subtree—Start searching from the base entry (as identified by the
base DN) and search everything below it, including the base entry.
Subtree is the default search scope.
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— One level—Searches only entries that are exactly one level below
the base entry.

• Search filter: a legal LDAP filter used to refine the search of the
external server. Objectclass=person is the default.

Search filter examples:

— (&(l=Toronto)(objectclass=person)) : To select entries that have a
locality of "Toronto" and an objectclass of "person".

— (&(objectclass=person)(|(sn=Smith)(cn=Joe M*))) : To select entries
that have an objectclass of "person" and a surname of "Smith" or
common name that starts with "Joe M".

Attribute Map
For every synchronization job you must define an attribute map using the
Attribute Map section of the LDAP Subscriber Synchronization Job window.

The attribute map is a table where each row represents one relation. To
define a relation you must provide three pieces of information:

• The name of an attribute in the external directory server

• The name of the corresponding attribute in CND. For more information,
see Appendix "Subscriber attributes" (page 185).

• The direction of the synchronization

Use the Load Default button to load a default attribute map based on
the external directory server type. As part of this operation, the LDAP
Subscriber Synchronization tool queries the external server and CND for a
list of available attributes. This list is then used to populate selection controls
in the appropriate cells of the attribute relation table. All this requires proper
configuration of the connection parameters to the external server.

A default attribute mapping of the supported LDAP servers populates the
attribute mapping table in the LDAP Subscriber Synchronization job window.

Table 5 "Default attribute maps" (page 82) shows you the default attribute
maps.

Table 5
Default attribute maps

Description

Active
Directory 2000
and
Exchange
Server 2000

Active
Directory 2003
and
Exchange
Server 2003

Sun Java System
Directory Server
5.2 CND

First name givenName givenName givenName givenName
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Description

Active
Directory 2000
and
Exchange
Server 2000

Active
Directory 2003
and
Exchange
Server 2003

Sun Java System
Directory Server
5.2 CND

Middle name initials initials initials initials

Last Name sn sn sn sn

Street streetAddress street street street

City l l l l

Province/
State

st st st st

Postal Code postalCode postalCode postalCode postalCode

Country co co country

Email mail mail mail mail

Employee
ID

employeeID employeeNumber employeeNumber employeeNumber

Title title title title title

Description description description description description

Department department departmentNumber departmentNumber departmentNumber

Unique
Identifier

uid uid uid uid

ATTENTION
A default attribute map must be successfully loaded to create attribute relations.

If you click the Load Default button against a map that is already configured
with attribute relations, the default mappings for the server type are
substituted. A warning appears, indicating that this is happening, and you
must confirm the operation before continuing.

Remove selected
The Remove Selected button removes the selected attribute relation from
the map.

Add attribute relation
The Add Attribute Relation button generates a new empty row in the table
for the administrator to edit.

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



84 LDAP Subscriber Synchronization

Advanced Options window
The Advanced Options window (Figure 16 "Advanced Options window"
(page 84)) accessible from the Advanced button of the LDAP Subscriber
Synchronization Job window, allows you to configure the following LDAP
Subscriber Synchronization Job options:

• Whether to add new entries to CND, if unmatched entries are found in
the external directory

• Whether to attempt to resolve new entries in the external server with
existing CND entries, and which attributes in both servers to use to
resolve them

• Whether to use TLS/SSL encrypted communications with the external
directory server

• Whether to use TLS/SSL encrypted communications with CND

• Whether to generate a transaction log for the synchronization job

Figure 16
Advanced Options window
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Progress monitor window
When you select a synchronization job and click Run on either the
LDAP Subscriber Synchronization main window or the LDAP Subscriber
Synchronization Job window, the progress monitor windows appear.

See Figure 17 "Run LDAP synchronization job window" (page 86).

The first window is the Run LDAP synchronization job window.

The LDAP synchronization job window has the following sections:

• Job details—Outlines Job name, external directory server host, and
external directory server search filter from the saved synchronization job.

• Job status—Lists total number of entries, number of entries
synchronized and number of entries that failed to synchronize. By
default, when the Run LDAP synchronization job window first appears,
there are no values for any of these entries until you click Start.

• Job Progress—When you click Start, the blue progress monitor goes
back and forth near the bottom of the Run LDAP synchronization
job window with the message "Preparing to execute synchronization
job...". At this time, the number of entries to be synchronized is being
determined.

When the number of entries to be synchronized between an external
directory server and CND is determined, this tool starts to synchronize
data. The progress bar starts to display the progress of the operation.
The total number of entries, number of entries synchronized and the
number of entries that failed to synchronize are also displayed at this
time. These numbers, as well as the progress bar, are updated as the
job progresses.

• Start and Close in this window are the only available choices when
the job is not started.

Click Close to close the Run LDAP synchronization job window after a
synchronization job is completed or cancelled.

When synchronization is in progress, only Cancel is available. Click Cancel
to stop the synchronization job.
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Figure 17
Run LDAP synchronization job window

If you click Start, the job progress bar displays across the bottom of the
window.

Logging
The types of LDAP Subscriber Synchronization logs are:

• Summary logs

• Transaction logs

• Failure logs

Log file locations
There is only one summary log. Each job may also generate a transaction
or a failure log. The location of the transaction log and the failure log for
each job is indicated in that job’s summary log entry.

For each synchronization job executed new directories are created to hold
the transaction log (optional) and the failure log (if generated).

The name of the directory is generated and comprised of the name of the
synchronization job and an appended system timestamp. For example:
NightlySync_20050419120000
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In the above example, the year is 2005, the month is April, the date is the
19th and the time is 12 noon.

Summary log
There is one summary log that contains an entry for each synchronization
job executed by the system. The log contains the following details about
each job:

• Synchronization job name

• External directory server host name

• CND server host name

• Start and completion timestamp

• Number of entries successfully synchronized

• Number of entries that failed to be synchronized

• Location of the failure log, if one exists

• Location of the transaction log, if one exists

• Status of the job (completed, interrupted during synchronization,
interrupted during cleaning, aborted during synchronization, aborted
during cleaning)

You access the summary log from the LDAP Subscriber Synchronization
main window using the View menu. For more information, see Figure 20
"View summary log" (page 97).

Transaction log
One transaction log is optionally created for every synchronization job. This
optional log provides the following details for each entry synchronized by
the system:

• Destination DN of the entry

• source host

• source entry DN

• source attribute modifications

• destination host

• For each synchronized attribute in the entry, the following is recorded:

— attribute name

— original value

— new value
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Failure log
For each synchronization job a failure log is generated, if a failure occurs
during the synchronization.

ATTENTION
If a failure occurs, any entries that have been updated to that point remain
updated.

The following details are captured for each failure:

• the location of the failure (SRC or DEST)

• the host (or IP address) where the failure occurred

• the operation that failed

• the details of the failure

• the timestamp when the error occurred

Procedures for LDAP Subscriber Synchronization
The procedures in this section are:

• Procedure 25 "Launching LDAP Subscriber Synchronization" (page 88)

• Procedure 26 "Creating a new basic synchronization job" (page 90)

• Procedure 27 "Creating a new advanced Import LDAP Subscriber
synchronization job " (page 91)

• Procedure 28 "Running a synchronization job using the LDAP
Subscriber Synchronization main window" (page 93)

• Procedure 29 "Running a synchronization job using the LDAP
Subscriber Synchronization Job window" (page 93)

• Procedure 30 "Modifying an existing synchronization job" (page 94)

• Procedure 31 "Deleting an existing synchronization job" (page 95)

• Procedure 32 "Viewing Summary log" (page 97)

Procedure 25
Launching LDAP Subscriber Synchronization

Step Action

1 Select All Programs > Nortel > Common Network Directory >
CND Manager from the Start menu.

or

Click the CND Manager desktop shortcut.

The CND Manager login window appears.

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



Procedures for LDAP Subscriber Synchronization 89

2 Enter the CND Administrator password.

The password entered here is the same one used during installation.

3 Click OK to log in.

The CND Manager launches.

4 Select Tools > Subscriber synchronization > LDAP Subscriber
Synchronization on the Common Network Directory Manager
window.

The Nortel Common Network Directory LDAP Subscriber
Synchronization main window opens as shown in Figure 18 "Nortel
Common Network Directory LDAP Subscriber Synchronization main
window" (page 89).

Figure 18
Nortel Common Network Directory LDAP Subscriber Synchronization
main window

ATTENTION
The first time you see this window, there are no jobs listed under Saved
Synchronization Jobs.

—End—
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Procedure 26
Creating a new basic synchronization job

Step Action

1 Launch the LDAP subscriber Synchronization page. See
Procedure 25 "Launching LDAP Subscriber Synchronization" (page
88).

2 From the LDAP Subscriber Synchronization main window, either:

a. Click New.

or

b. Select File > New.

The Subscriber Synchronization Job page appears.

3 In the Subscriber Synchronization Job window, provide values for
the external directory server connection details:

• Host

• Bind DN

• Password

• Base DN

• Server type

• Port

For more information, see "External Directory Server Connection
Details Search Parameters" (page 81) for explanations of these
fields.

4 In the Subscriber Synchronization Job window provide values for
the search parameters:

a. Search scope (or accept the default).

b. Search filter, if any (or accept the default).

5 In the Subscriber Synchronization Job window define the attribute
map for the synchronization job:

Click Load Default to retrieve the available attributes for the external
server and CND, and to load a default attribute map.

6 Modify the existing Attribute Map as necessary:

• To delete an attribute relation, select the attribute relation and
click Remove selected.
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• To add a new attribute relation click Add attribute relation and
modify the values in each of the columns to select an external
directory server attribute, a CND attribute, and a direction.

• To modify an existing attribute relation, click on the attribute and
modify the values by selecting from the list.

7 Click Save to save the new job.

The Save as dialog screen appears.

8 Enter the name of the newly created job in the text field of the Save
as dialog screen.

9 Click OK.

10 Click Close.

The newly created subscriber synchronization job appears in the list
of the Saved Synchronization Jobs.

—End—

Procedure 27
Creating a new advanced Import LDAP Subscriber synchronization job

Step Action

1 Create a new basic synchronization job, see steps 1 to 6 of
Procedure 26 "Creating a new basic synchronization job" (page 90).

2 Click Advanced in the LDAP Subscriber Synchronization Job
window.

The Advanced Options window appears.

3 Select the advanced options which meet your job requirements.
For detailed information on the different options see Table 6 "LDAP
Subscriber Synchronization advanced options" (page 92).

4 Click OK to close the Advanced Options window.

5 Click Save to save the new job.

The Save as dialog screen appears.

6 Enter the name of the newly created job in the text field of the Save
as dialog screen.

7 Click OK.

8 Click Close.
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The newly created subscriber synchronization job appears in the list
of the Saved Synchronization Jobs.

—End—

Table 6
LDAP Subscriber Synchronization advanced options

Option Description

Import unmatched Using importing, LDAP Subscriber Synchronization
adds unmatched entries to CND.
This option is selected by default.

Resolve unmatched Select this option to resolve unmatched LDAP
Subscriber entries with existing CND entries.
The values of the External Directory server attribute
and the CND attribute must match to identify an
entry pair to be mapped.

Use TLS/SSL for Directory
Server

Select this option to enable Transport Layer
Security/Secure Sockets Layer (TLS/SSL)
communication with Directory Server.
Ensure that the external directory server is configured
to accept connections on the secure port.
The use of TLS/SSL encryption is optional but is
recommended.

Use TLS/SSL for CND Select this option to enable Transport Layer
Security/Secure Sockets Layer (TLS/SSL)
communication with CND.
Ensure that CND is configured to accept connections
on the secure port.
The use of TLS/SSL encryption is optional but is
recommended.
For LDAP synchronization to run over SSL, the
JRE’s keystore must be configured with certificates
for each server it wants to talk to as a client.

Enable transaction
logging

Select this option to have transaction logging
enabled.
One transaction log is optionally created for every
synchronization job. This optional log provides
details for each entry synchronized by the system.

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



Procedures for LDAP Subscriber Synchronization 93

Procedure 28
Running a synchronization job using the LDAP Subscriber Synchronization
main window

Step Action

1 Launch the LDAP Subscriber Synchronization page. See Procedure
25 "Launching LDAP Subscriber Synchronization" (page 88).

2 Select the LDAP synchronization job you want to run.

3 Click Run.

or

Select File > Run.

The Run LDAP synchronization job window appears.

4 Click Start to start the job synchronization.

The status of the synchronization can be monitored in the Job Status
section or Job Progress section.

5 Click Close when the job is completed to return to the LDAP
Subscriber Synchronization main window.

6 Click Close to return to the CND Manager main window.

—End—

Procedure 29
Running a synchronization job using the LDAP Subscriber Synchronization
Job window

Step Action

1 Launch the LDAP Subscriber Synchronization page. See Procedure
25 "Launching LDAP Subscriber Synchronization" (page 88).

2 Select one of the following two options to get to the LDAP
Subscriber Synchronization job window:

• Select the job you wish to run from the LDAP Synchronization
Main Window.

— Click Open.

or

Double-click the job.

or
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Select File > Open.

• Create a new basic subscriber synchronization job. See
Procedure 26 "Creating a new basic synchronization job" (page
90).

3 Click Run.

or

Select File > Run.

The Run LDAP synchronization job window appears.

4 Click Start to start the job synchronization.

The status of the synchronization can be monitored in the Job Status
section or Job Progress section.

5 Click Close when the job is completed to return to the LDAP
Subscriber Synchronization main window.

6 Click Close to return to the CND Manager main window.

—End—

Procedure 30
Modifying an existing synchronization job

Step Action

1 Launch the LDAP subscriber Synchronization page. See
Procedure 25 "Launching LDAP Subscriber Synchronization" (page
88).

2 Select the synchronization job you wish to modify from the list of
Saved Sync Jobs.

3 Click Open.

or

Select File > Open.

or

Double-click the job to modify.

The Subscriber Synchronization Job dialog page appears.

4 Modify the basic parameters for the selected Subscriber
Synchronization job. For detailed information about the parameters
see "LDAP Subscriber Synchronization Job window" (page 80).
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5 Click Advanced to modify the advanced synchronization job
parameters.

The advanced parameters page appears.

6 Modify the advanced parameters. For details about advanced
parameters see Table 6 "LDAP Subscriber Synchronization
advanced options" (page 92).

7 Click OK to save changes to the advanced parameters.

or

Click Cancel to exit the advanced parameter page.

8 Select one of the following two options:

• Select File > Save As to save a new copy of the job.

The Save as dialog box appears.

or

• Select File > Save to save the changes to the existing job, and
proceed to step 11.

9 Enter the new Synchronization job name in the text box.

10 Click OK to save the file.

or

Click Cancel to cancel the save of the new copy.

11 Click Close.

If you have not saved a copy of the job, a warning Save dialog box
appears, asking if you want to save the change. Select Yes or No,
depending on what you want to do.

—End—

Procedure 31
Deleting an existing synchronization job

Step Action

1 Launch the LDAP subscriber Synchronization page. See
Procedure 25 "Launching LDAP Subscriber Synchronization" (page
88).

2 Select the synchronization job you wish to delete from the list of
Saved Synchronization Jobs.
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3 Click Delete.

or

select File > Delete.

A Delete warning dialog box appears, asking if you are sure you
want to delete the synchronization job.

4 Click Yes to confirm deletion.

or

Click No to cancel the request.

If CND manager has scheduled jobs a reminder appears, reminding
you to delete any tasks that use the scheduler (see Figure 19
"Synchronization job deleted reminder" (page 96)).

Figure 19
Synchronization job deleted reminder

ATTENTION
If you delete a synchronization job it does not remove any references to it
in the Windows scheduler. You must remove the job from the scheduler
separately. For more information about Removing a synchronization job
from the scheduler, see Procedure 35 "Removing a synchronization job
from the scheduler" (page 101).

5 Click Close.

A message dialog appears if you have scheduled tasks, reminding
you to delete any scheduled tasks using this Synchronization job
procedure.

—End—
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Procedure 32
Viewing Summary log

Step Action

1 Launch the LDAP subscriber Synchronization page. See
Procedure 25 "Launching LDAP Subscriber Synchronization" (page
88).

2 Select the synchronization job which you wish to view from the list of
Saved Synchronization Jobs.

3 Select View > Summary log, see Figure 20 "View summary log"
(page 97).

Figure 20
View summary log

A window similar to that in Figure 21 "Sample Summary Log" (page
98) appears. The data you see depends on your configuration and
the jobs you have run.

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



98 LDAP Subscriber Synchronization

Figure 21
Sample Summary Log

ATTENTION
The transaction and failure logs are available at the paths specified in
the summary log.

4 Click the X on the Summary Notepad window to close the summary
log (see Figure 21 "Sample Summary Log" (page 98)).

5 Click Close on the Saved Synchronization Jobs window to exit.

—End—

Scheduling LDAP Subscriber Synchronization jobs
Use the Windows scheduler to perform job scheduling and scheduled task
monitoring.

The procedures in this section are :

Procedure 33 "Scheduling a synchronization job" (page 99)
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Procedure 34 "Modifying a scheduled synchronization job" (page 101)

Procedure 35 "Removing a synchronization job from the scheduler" (page
101)

Procedure 33
Scheduling a synchronization job

Step Action

1 Open the Windows Control Panel.

• On Windows XP, select Start > Control Panel.

• On Windows Server 2003, select Start, right-click Control Panel
and select the Open command.

• On Windows 2000 and Windows 2000 Server systems, select
Start > Settings > Control Panel.

2 Double-click the Scheduled Tasks shortcut.

3 In the Scheduled Tasks explorer, double-click Add Scheduled Task.

4 In the introductory screen of the Scheduled Task Wizard click Next.

5 Select Browse on the next screen and use the Select Program to
Schedule window and navigate to the CND install folder (C:\Program
Files\Nortel\Common Network Directory).

6 Select the runSyncJob.jar file.

7 Provide a name for the scheduled task and select the frequency.
Click Next.

8 Provide a schedule for the synchronization job to run (this step can
vary, depending on the frequency selected in the previous step).
Click Next.

9 Provide the account name and password with which to run the
synchronization job. (Use an account on the PC that has the
privileges to run this program). Click Next.

10 Click the check box beside Open advanced properties for this
task when I click Finish.

11 Click Finish to open the Advanced Options window.

12 In the Run box enter:

javaw -jar runSyncJob.jar -jobName savedJobName
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For savedJobName, substitute the name of the saved job you want
to run. See Figure 22 "Example of Run box on Advanced Options
window" (page 100).

ATTENTION
In the example, the job is called ExchangeSync.

Figure 22
Example of Run box on Advanced Options window

13 Click Apply to accept the change.

14 When prompted, provide the password for the account identified in
step 9.

15 Click OK to close the password window.

16 Click OK to close the Advanced Options window.
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—End—

Procedure 34
Modifying a scheduled synchronization job

Step Action

1 Open the Windows Control Panel.

• On Windows XP, select Start > Control Panel.

• On Windows Server 2003, select Start, right-click Control Panel
and select the Open command.

• On Windows 2000 and Windows 2000 Server systems, select
Start > Settings > Control Panel.

2 Double-click the Scheduled Tasks shortcut.

3 In the Scheduled Tasks explorer, double-click the task you want to
modify.

4 In the Scheduled Tasks properties window make the required
changes using the tabs.

5 Click Apply to accept the change.

6 Provide the password for the account identified in step 9 of
Procedure 33 "Scheduling a synchronization job" (page 99).

7 Click OK to close the password dialog.

—End—

Procedure 35
Removing a synchronization job from the scheduler

Step Action

1 Open the Windows Control Panel.

• On Windows XP, select Start > Control Panel.

• On Windows Server 2003, select Start, right-click Control Panel
and select the Open command.

• On Windows 2000 and Windows 2000 Server systems, select
Start > Settings > Control Panel.
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2 Double-click the Scheduled Tasks shortcut.

3 In the Scheduled tasks explorer select the scheduled task you want
to remove.

4 Select File > Delete.

or

Right-click for a context menu and select Delete.

5 Click Yes in the Confirm File Delete window to delete.

or

Click No to cancel the deletion.

—End—
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CSV Subscriber Synchronization

Contents
This section contains the following topics:

• "Introduction" (page 103)

• "File Format" (page 103)

• "Determining the operation to perform" (page 106)

• "Details for imported subscribers" (page 107)

• "Operational conditions" (page 108)

• "Synchronizing subscribers in CND" (page 108)

• "CSV subscriber synchronization limitations" (page 110)

• "Error handling" (page 111)

• "Logging" (page 112)

Introduction
This section describes the Comma Separated Values (CSV) subscriber
synchronization feature that allows you to import new subscribers and
update existing subscribers using data in a CSV file.

File Format
Each row in the CSV file, other than the first row, is treated as an individual
subscriber record. The first row is used to identify the fields in all the
remaining records in the file. These field names correspond to Lightweight
Directory Access Protocol (LDAP) attribute names in the Common Network
Directory (CND).
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Supported attributes
While the CSV export feature "CSV Subscriber Export" (page 139) only
supports a fixed set of the legal nortelSubscriber attributes, the
synchronization feature is slightly less restrictive. CSV subscriber
synchronization imports or updates nortelSubscriber attributes, with the
following restrictions:

• The attribute must not be a binary type attribute, such as jpegPhoto
or audioClip.

• The attribute must not be operational, such as modifyTimestamp.

• The cn (common name) attribute cannot be modified.

• The userPassword attribute cannot be modified.

Multi-valued attributes
Within the CSV file, field values are separated by commas. To facilitate the
import and update of those LDAP attributes that support multiple values,
each field value can be further delimited by semi-colon (;). To include a
semicolon as a character in a single value for an attribute, the semicolon
must be preceded by a backslash. Table 7 "Semicolon interpretation" (page
104) shows examples of how semicolons are interpreted.

Table 7
Semicolon interpretation

CSV field data Interpretation

A;B Value 1: A

Value 2: B

A\;B Value 1: A;B

A\;B;C Value 1: A;B

Value 2: C

Any attempt to import or update multiple values against an LDAP
attribute that does not support multiple values is an error and causes the
synchronization for that entry to fail. Any such failures are logged (see
"Logging" (page 112)).

See Table 14 "Subscriber attributes in CND" (page 185) for LDAP attributes
supporting multiple values.

Deleting attributes
CSV subscriber synchronization supports the deletion of individual
subscriber attributes in CND. A special value is used to indicate that all
current values in the current subscriber entry for the specified attribute
should be deleted in CND. The special value is
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[DELETE]

Figure 23 "CSV file with attribute deletion" (page 105) shows a CSV file that
uses attribute deletion to delete all values for the subscriberType attribute
for two subscribers.

Figure 23
CSV file with attribute deletion

File encoding
The CSV synchronization feature supports reading files encoded using
any of the following:

• 8-bit Unicode Transformation Format (UTF-8)

• 16-bit Unicode Transformation Format with big-endian byte order
(UTF-16BE)

• 16-bit Unicode Transformation Format with little-endian byte order
(UTF-16LE)

• the default encoding of the machine running CND Manager

Rather than ask its users to identify the encoding of a selected CSV file,
CSV synchronization relies on the presence of the Unicode byte order mark
(BOM) to identify the file’s encoding. For details on the use of the byte-order
mark, see Appendix "Unicode byte-order mark" (page 197).

If a selected CSV file starts with the BOM as encoded by UTF-8, UTF-16BE,
or UTF-16LE, CND Manager reads the remainder of the file using that
encoding. If no BOM is detected at the start of the CSV file, CND Manager
reads the file using the default encoding of the machine on which its
running. Note that CSV files created using the CSV export feature are
always encoded using UTF-8 and always start with the BOM encoded using
UTF-8 (see "File encoding" (page 141)).
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Determining the operation to perform
The CSV subscriber synchronization feature examines each record in the
CSV file and determines which of the following operations to perform:

• update an existing CND subscriber

• import a new CND subscriber

• ignore the record

These operations are named update, import, and ignore, respectively.
Figure 24 "CSV subscriber synchronization operation decision-making
algorithm" (page 106) shows the algorithm used on each CSV record to
determine the operation to perform.

ATTENTION
The same CND subscriber can be updated by more than one record in the CSV
file.

Figure 24
CSV subscriber synchronization operation decision-making algorithm

The presence of a non-empty entryUUID value determines the operation
to perform:

• If a CSV record has a non-empty entryUUID value and an existing CND
subscriber has the specified entryUUID, the operation is update; that
subscriber is updated according to the details in the CSV record.

• If a CSV record has a non-empty entryUUID value but there is no
subscriber in CND that has the specified entryUUID, the operation is
ignore. This is noted in the failure log.
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• If entryUUID does not appear in the CSV file’s header or a CSV record
has an empty value for that field, the operation is import; that record is
imported to CND as a new subscriber.

Details for imported subscribers
The following details apply only to imported subscribers:

• "Common names for imported subscribers" (page 107)

• "Required attributes" (page 108)

Common names for imported subscribers
New subscribers imported to CND must have a unique common name. This
section discusses the different common name options available when CSV
subscriber synchronization imports new subscribers. The options are:

• Use common names specified in the CSV file. Using this option,
common names are taken directly from the CSV file; no common names
are generated. If a common name is not specified in the CSV file for a
record that requires one, it is an error condition that is logged in the
failure log (see "The failure log" (page 115)).

• Generate common names by combining given name and surname.
Using this option, common names are generated using a combination
of the givenName and sn attributes for any record in the CSV file that
doesn’t have a common name specified. The possible combinations are:

— Given Name and surname (for example “John Doe”)

— Surname, Given Name (for example “Doe, John”)

— First initial and surname (for example “JDoe”)

— Surname and first initial (for example “DoeJ”)

In the event that the givenName attribute is empty for a record when
this option is chosen, the sn attribute is used alone, and the format
of the resulting common name does not include an additional space
or a comma. For example, the generated common name is “Doe”
for a subscriber with a surname of “Doe” and an empty givenName,
regardless of the chosen combination.

• Generate common names using values of another attribute. Using
this option, common names are generated using another specified
attribute in the CSV file for any record in the CSV file that doesn’t have a
common name specified.

It is an error if a subscriber being imported has a common name that is the
same as the value of the common name of an existing CND subscriber.
In this situation the error is logged in the failure log (see "The failure log"
(page 115)).
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Required attributes
In CND, subscribers must have a surname. Therefore, a CSV record for
an imported subscriber must have a non-empty value for the sn attribute
specified in the CSV file. It is an error if a subscriber being imported does
not have a surname. In this situation the error is logged in the failure log
(see "The failure log" (page 115)).

Operational conditions
Following is a list of operational conditions that apply to CSV subscriber
synchronization:

• Attempting to delete required attributes results in a failure to update the
subscriber in question, and is logged in the failure log (see "The failure
log" (page 115)).

• Attribute deletion only works when the operation being performed is an
update (see "Determining the operation to perform" (page 106)). If the
operation is an import, any [DELETE] directives are ignored.

• Attempting to delete an attribute that has no values does nothing and
is not considered an error.

• Deleting an attribute deletes all of its values.

• Modifying an attribute replaces all of its existing values.

Synchronizing subscribers in CND
To synchronize subscribers in CND see Procedure 36 "Synchronizing
subscribers in CND" (page 108).

Procedure 36
Synchronizing subscribers in CND

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Subcriber synchronization > CSV subscriber
synchronization (see Figure 25 "CSV subscriber synchronization
tools menu item" (page 109)).
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Figure 25
CSV subscriber synchronization tools menu item

The CSV subscriber synchronization dialog screen appears.

3 Click Browse on the CSV subscriber synchronization dialog screen
to select the CSV file with which to synchronize.

4 Select the appropriate CSV file on the Windows Explorer screen.

5 Click Open.

6 Select the appropriate CSV file format. Note that CSV files
generated with the CSV subscriber export feature use the Microsoft
CSV format.

7 Click Next.

The Common names for imported subscribers dialog screen
appears.

8 Select a common name option for imported subscriber entries.
The choices are:

• Generate common names by combining given name and
surname
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• Generate common names by using the value of another
attribute

The option Use common names specified in the CSV file is
disabled.

9 Click Next.

10 Verify the items listed in the Current selections window.

11 Click Finish to start synchronizing subscribers.

The CSV subscriber synchronization progress dialog indicates the
progress of the synchronization job.

or

Click Back to return to previous menus to make modifications.

or

Click Cancel to abort the synchronization.

When the job is completed, the CSV subscriber synchronization
dialog indicates the location of the transaction log and, if applicable,
the location of the failure log If you receive a failure error, see Table
8 "Error handling in CSV subscriber synchronization" (page 111).

12 Click Close to close the synchronization progress page.

—End—

CSV subscriber synchronization limitations
Following is a list of CSV subscriber synchronization limitations:

• Synchronization of accounts is not supported.

• Synchronization of binary attributes (for example, jpegPhoto and
audioClip) is not supported.

• Deletion of subscribers is not supported.

• Statistics that differentiate between imported entries and updated
entries are not collected or displayed.

• Subscribers that are not direct children of the ou=Subscribers,
dc=Nortel, dc=com container of the CND are not synchronized.

• Transaction logging is non-configurable.
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Error handling
Table 8 "Error handling in CSV subscriber synchronization" (page
111) shows how error conditions are handled:

Table 8
Error handling in CSV subscriber synchronization

Error condition System response Troubleshooting

No file is specified. A standard error dialog is
displayed. The text on the
dialog is:

“Enter a CSV file and then press
Next.”

Use the Browse… button to
select a CSV file.

The file does not exist. A standard error dialog is
displayed. The text on the
dialog is:

“File does not exist. Check file
path.”

Use the Browse… button to
select a CSV file.

The file is empty. A standard error dialog is
displayed. The text on the
dialog is:

“The file is empty.”

Use the Browse… button to
select a CSV file that is not
empty.

The file has a header, but has
no records.

A standard error dialog is
displayed. The text on the
dialog is:

“The file has no records.”

Use the Browse… button to
select a CSV file that has
records.

The system is unable to read
the file.

A standard error dialog is
displayed. The text on the
dialog is:

“Unable to read CSV file.”

Ensure that the CSV file:

• exists

• is readable

• isn’t locked by another
process, for example
Microsof Excel

The CSV file has neither sn nor
entryUUID in its header.

A standard error dialog is
displayed. The text on the
dialog is:

“The file’s header must include
at least one of the following
attributes:

• sn

• entryUUID”

Add either an sn column or
entryUUID column to the CSV
file.
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There is an unsupported
attribute in the CSV file’s
header.

A standard error dialog is
displayed. The text on the
dialog is:

"Field <field number> (<attribute
name>) in the header of <file
name> is unsupported" (If the
unsupported attribute’s name is
too long, it is abbreviated with
ellipsis (“…”) to ensure that the
error dialog is readable.)

Remove the column with the
unsupported attribute.

An attribute is duplicated in the
CSV file’s header.

A standard error dialog is
displayed. The text on the
dialog is:

"<attribute name> is duplicated
in the file’s header."

Remove the duplicate column
or rename the header.

The connection to the CND
service is unavailable.

A standard error dialog is
displayed. The text on the
dialog is:

“The CND service is
unavailable.”

Try to start the CND service
using the Windows Services
applet. If this fails, see Appendix
"CND Troubleshooting" (page
155)

The connection to the CND
service is lost after the
synchronization has started.

A standard error dialog is
displayed and the export job
is terminated. The text on the
dialog is:

“Lost connection to the CND
service. The synchronization
job has been terminated.”

Try to start the CND service
using the Windows Services
applet. If this fails, see Appendix
"CND Troubleshooting" (page
155)

Logging
For each synchronization job the following logs are generated:

• "The summary log" (page 112)

• "The transaction log" (page 114)

• "The failure log" (page 115) (potentially)

ATTENTION
Log files are not automatically cleaned by the system. It is recommended that you
periodically remove unwanted log files.

The summary log
Each time a CSV subscriber synchronization job is run, the summary details
for the job are recorded in the LDAP Synchronization summary log.
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The summary log holds summaries of all synchronization-related CND
tasks, including:

• LDAP subscriber synchronization jobs

• CallPilot Global Address Book synchronization jobs

• CSV subscriber synchronization

The file is located at the following path:

<CND installation folder>\log\ LDAP_Sync\Summary.log

Where <CND installation folder> is the folder where CND is
installed, which defaults to:

C:\Program Files\Nortel\Common Network Directory

The details in the summary log are:

• Sync Job Name: For CSV subscriber synchronization jobs, the name is
always “CSV_Sync”.

• External directory server host: For CSV subscriber synchronization
jobs, the host is the path and filename of the CSV file used in the job.

• Destination (CND) host: For CSV subscriber synchronization jobs,
the destination shows the IP address of the CND that the job was run
against.

• Job Status: Is one of:

— COMPLETED – the job completed normally

— ABORTED_DURING_SYNCING – the job failed to complete due
to an exceptional circumstance

— INTERRUPTED_DURING_SYNCING – the job failed to complete
because you cancelled it

• Sync started at: The time the job started.

• Sync ended at: The time the job finished.

• User account name: This is the Windows user ID of the currently
logged in user on the PC where the synchronization was run.

• Sync stats: The statistics of the job, which includes:

— Source host: For CSV subscriber synchronization job, this is always
“CSV_SYNC”.

— CSV_SYNC: Is one of:

– SYNC_COMPLETE_NORMAL – the synchronization was
completed normally
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– SYNC_COMPLETE_ABORT – the synchronization was
terminated before it finished due to an exceptional circumstance

– SYNC_COMPLETE_NO_ENTRIES – the synchronization was
completed, but there are no records in the CSV file

– SYNC_INTERRUPTED – the synchronization was cancelled
by the user

— TOTAL: The number of entries synchronized. The number of entries
that failed to synchronize.

• Cleaning stats: Not applicable to CSV subscriber synchronization.

• Failure log path: If a failure log is generated, this field displays the path
in the file system to that log file. Otherwise, "N/A" is displayed.

• Transaction log path: The path in the file system to the transaction log.

See Figure 26 "CSV subscriber synchronization summary log" (page
114) for an example of a summary log.

Figure 26
CSV subscriber synchronization summary log

The transaction log
For every CSV subscriber synchronization job run, a transaction log
(Transaction.log) file is created and stored in the following directory:

<CND installation
folder>\log\LDAP_Sync\CSV_Sync_[date]_[time]\
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Where [date] and [time] are generated based on the date and time that
the synchronization job started. For example, for a synchronization job
started on January 7, 2007 at 10:05:47 am, the generated folder is named
CSV_Sync_20070107_100547.

The CSV subscriber transaction log contains the following details:

• DN:

• Attributes:

See Figure 27 "CSV subscriber synchronization transaction log" (page
115) for an example of a transaction log.

Figure 27
CSV subscriber synchronization transaction log

The failure log
For every CSV subscriber synchronization job run that has failures, a failure
log (Failure.log) file is created and stored in the following directory:

<CND installation
folder>\log\LDAP_Sync\CSV_Sync_[date]_[time]\

Where [date] and [time] are generated based on the date and time
that the synchronization job started. For example, for a synchronization job
started on January 7, 2007 at 10:05:47 am, the generated folder is named
CSV_Sync_20070107_100547
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The failure log contains the following details:

• The location of the failure. In a CSV subscriber synchronization job,
the location is either the destination (DEST) if the error occurred in the
CND, or source (SRC) if the error is caused by the CSV file.

• Location: In a CSV subscriber synchronization job, the host is always
the IP address of the CND.

• Host: The IP address.

• Entry DN: The cn, ou, and dc of the job.

• Operation: The operation that failed.

• Details: The details of the failure.

• Time: The date and time that the failure occurred.

See Figure 28 " CSV subscriber synchronization failure log" (page 116) for
an example of a failure log.

Figure 28
CSV subscriber synchronization failure log
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CallPilot Global Address Book
Synchronization

Contents
This section contains information on the following topics.

• "Introduction" (page 117)

• "Functional description" (page 118)

• "Log files" (page 119)

• "Passwords" (page 121)

• "CallPilot GAB Synchronization dialog" (page 121)

• "CallPilot GAB progress dialog" (page 128)

• "CallPilot GAB Synchronization Procedures" (page 129)

Introduction
This chapter describes CallPilot Global Address Book Synchronization, a
Common Network Directory (CND) Manager tool. The tool allows a CallPilot
network administrator to consolidate the local address books of all CallPilot
5.0 hosts in a network into a global address book (GAB) having entries
stored as subscribers in CND. Additionally, the tool ensures that each CND
subscriber entry is kept up-to-date with respect to the CallPilot 5.0 local
address book entry with which it is associated.

When local address books are consolidated into a global address book,
each subscriber can address a message to a colleague regardless of
where that colleague works. Without consolidation, a subscriber can only
address a message to a colleague if the information of the subscriber and
colleague is stored in the same local address book. CND subscriber entries
associated with a CallPilot local address book entry store information such
as given name, initials, surname, email address, title, and description in the
same way as subscribers created by other applications (such as CS1000
Telephony Manager). This approach allows other applications to share
subscriber data with CallPilot.
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Functional description
CallPilot Global Address Book Synchronization consists of two phases:

• Synchronization

• Cleaning

Synchronization phase
The first step of synchronization is to query a user-defined CallPilot (named
the CallPilot network authority) for a list of all CallPilot hosts that have been
configured in its networking tree using CallPilot Manager. The next step of
synchronization is to query each host. If the host is at release 5.0, it is
queried for a list of all of its local address book entries. If the host is at any
other release, its entries are not synchronized.

Each local address book entry results in potential changes to one CND
subscriber entry:

• If a CND subscriber entry is already associated with the local address
book entry, the CND subscriber entry is updated to reflect the information
in the local address book entry.

• If CND subscriber entry is not associated with the local address book
entry, one of the following occurs:

— If exactly one CND subscriber entry has the same surname, given
name, and telephone number as those details in the local address
book entry, the CND subscriber entry is associated with the local
address book entry. In addition, the CND subscriber entry is updated
to reflect the information in the local address book entry.

— If zero or more than one CND subscriber entry has the same
surname, given name, and telephone number as those details in the
local address book entry, a new CND subscriber entry is created to
reflect the information in the local address book entry. In addition,
the new entry is associated with the local address book entry.

Cleaning phase
Cleaning takes care of CND subscriber entries that have had all of the
associated CallPilot local address book entries deleted. Users have two
options for such entries:

• Only delete the CallPilot-specific attributes of the entry: Keep the entry
(with its other attributes) in CND. This option allows other applications to
use the remaining subscriber data stored in the entry.

• Delete the entire entry: Choose this option when CallPilot is the only
application using subscriber data in CND.
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ATTENTION
There is no fallback to the first option if entry deletion fails. For example, if a
CND subscriber entry cannot be deleted, its CallPilot-specific attributes are not
touched. Rather, the inability to delete the entry is logged as a failure to clean.

Log files
There are potentially three log files relevant to CallPilot Global Address
Book Synchronization:

• summary log file. See "Summary log file" (page 119)

• transaction log file. See "Transaction log file" (page 120)

• failure log file. See "Failure log file" (page 121)

All log files are stored within the LDAP_Sync\log folder that exists within
the CND installation folder (by default, C:\Program Files\Nortel\Common
Network Directory).

There is a single summary log file; it contains one record for each subscriber
synchronization job that is performed, whether it be Comma Separated
Values (CSV) subscriber import, CallPilot GAB synchronization, or
Lightweight Directory Access Protocol (LDAP) subscriber synchronization.
Note that a record is created whether the job is performed manually or
scheduled.

For each CallPilot GAB synchronization job that is performed, a unique
sub-folder within LDAP_Sync\log is created in which to store the
job transaction and failure log files. The sub-folder name starts with
CallPilot_GAB and ends with a string representation of the date and time
the job was started (for example, CallPilot_GAB_20051230_160704 for a
job that started at 4:07:04 PM on December 30, 2005).

Summary log file
The summary log file is named Summary.log and is located in the
log\LDAP_Sync sub-folder of the CND installation folder. It is plain text,
with records separated from one another by a line of asterisks. A record for
CallPilot GAB synchronization contains the following information:

• the fixed name of the CallPilot GAB synchronization job (CallPilot_GAB)

• the network authority host

• the CND host

• the status of the job – one of the following:

— completed
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— interrupted during synchronization – indicates that the job was
interrupted by you while synchronization was occurring

— interrupted during cleaning – indicates that the job was interrupted
by you while cleaning was occurring

— aborted during synchronization – indicates that the job was aborted
due to error while synchronization was occurring

— aborted during cleaning – indicates that the job was aborted due to
error while cleaning was occurring

• the account name of the user that ran the synchronization job

• the date and time the job started and ended

• for each source CallPilot host:

— the status of synchronization with the host: one of:

– unreachable: indicates that the host was not reachable

– synchronization not started: indicates that synchronization with
the host was not started

– synchronization completed

– synchronization aborted: indicates that synchronization with the
host was aborted due to error

– synchronization interrupted: indicates that synchronization with
the host was interrupted by the user

— the number of entries that synchronized and failed to synchronize

— the number of entries that were cleaned and failed to be cleaned

• the total number of entries that synchronized and failed to synchronize

• the total number of entries that were cleaned and failed to be cleaned

• the failure log path, if applicable

• the transaction log path, if applicable

Transaction log file
The transaction log file is optional; it is enabled or disabled in the CallPilot
GAB Synchronization Job dialog. See "Logging tab" (page 127). If enabled,
the file is named Transaction log and is located in the unique sub-folder of
the particular CallPilot GAB synchronization job. It is plain text, with records
separated from one another by a line of asterisks. The transaction log
file contains a record when any of the following events occur to a CND
subscriber entry:

• It is created.
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• It is associated with a CallPilot local address book entry.

• It is updated to reflect the information in its associated CallPilot local
address book entry.

• The CallPilot-specific attributes are deleted.

• It is deleted.

Failure log file
The failure log file contains a record for each entry that fails to be
synchronized or cleaned. Note that the failure log file is not the place that
failures of a magnitude larger than a single entry are logged. For example,
suppose that one of 100 CallPilot hosts is temporarily unavailable and the
synchronization tool can not get the list of local address book entries from
that host. That information is not logged in the failure log file, rather, it is
noted in the summary log file.

The failure log file is named Failure.log and is located in the unique
sub-folder of the particular CallPilot GAB synchronization job. It is in simple
text format, with records separated from one another by a line of asterisks.

Each record contains the following information:

• The distinguished name (DN) and host of the entry that caused the
failure.

• Whether the failure occurred on the source or destination of the
synchronization job.

• The operation being attempted.

• The time the failure occurred.

Passwords
There are potentially three passwords necessary to perform CallPilot Global
Address Book Synchronization:

• The CND Administrator password – assigned during CND installation
and configured using CND Manager.

• The password used when communicating with the CallPilot network
authority – configured in the CallPilot GAB Synchronization dialog box.

• The Windows account password under which scheduled CallPilot GAB
synchronization occurs.

CallPilot GAB Synchronization dialog
The CallPilot Global Address Book Synchronization dialog contains:

• A menu bar that allows a user to run the synchronization job, save the
details of the job, close the dialog, view the summary log, or view the
administration guide. See "Menu bar" (page 122).
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• A tab for configuration of network authority details. See "Network
authority tab" (page 124).

• A tab for configuration of attribute modification. See "Attribute
modification tab" (page 125).

• A tab for configuration of entry cleaning. See "Entry cleaning tab" (page
126).

• A tab for configuration of logging. See "Logging tab" (page 127).

• Three buttons:

— Run - to run the synchronization job

— Save - to save the details of the synchronization job

— Close - to close the dialog

Menu bar
The menu bar contains the following menus:

• File. See "File menu" (page 122)

• View. See "View menu" (page 123)

• Help. See "Help menu" (page 123)

File menu
The file menu contains menu items that allows you to run the synchronization
job, save the details of the job, or close the dialog. See Figure 29 "CallPilot
GAB Synchronization Job dialog File menu" (page 122)

Figure 29
CallPilot GAB Synchronization Job dialog File menu
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For the procedure to save the CallPilot GAB synchronization job, see
"Saving the CallPilot GAB synchronization job" (page 131)

For the procedure to run the CallPilot GAB synchronization job, see
"Running the CallPilot GAB synchronization job" (page 132)

View menu
The view menu has a single menu item that allows you to view the summary
log. Figure 30 "CallPilot GAB Synchronization Job dialog View menu"
(page 123).

Figure 30
CallPilot GAB Synchronization Job dialog View menu

Help menu
The help menu contains a single menu item that allows you to view the
CND Administration Guide. See Figure 31 "CallPilot GAB Synchronization
Job dialog Help menu" (page 124)
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Figure 31
CallPilot GAB Synchronization Job dialog Help menu

Configuration tabs
Network authority tab
The Network authority tab is used to configure network authority details and
contains text fields for the host, VPIM prefix, mailbox, and password. See
Figure 32 "CallPilot GAB Synchronization Job dialog Network Authority
tab" (page 124)

Figure 32
CallPilot GAB Synchronization Job dialog Network Authority tab
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The CallPilot details that are entered into the dialog is the network authority
that is queried for the list of all CallPilot hosts in the network. The VPIM
prefix, mailbox and password must be those of an administrator on the
CallPilot network authority with at least Directory Synchronization
Administration rights.

If a previous CallPilot GAB synchronization job has been saved, the saved
values are pre-populated as the dialog defaults. Otherwise, all text fields are
blank and the Save password check box is not selected.

Host validity The host field ignores leading and trailing white space. For
example, a host of “ CallPilotA ” is equivalent to a host of “CallPilotA”.
The host must be a non-empty string (after leading and trailing white space
is removed). If you try to run CallPilot GAB synchronization when the host
is invalid, the following error message is displayed that states, "The host is
invalid. It must be : ".

After you acknowledge the error message, input focus is moved to the host
text field.

VPIM prefix validity The VPIM prefix must be a sequence of one or more
digits. If you try to run CallPilot GAB synchronization when the VPIM prefix
is invalid, the following error message is displayed, "The VPIM prefix is
invalid. It must be a sequence of one or more digits."

After you acknowledge the error message, input focus is moved to the VPIM
prefix text field.

Mailbox validity The mailbox must be a sequence of between one and 18
digits. If you try to run CallPilot GAB synchronization when the mailbox is
invalid, the following error message is displayed, "The mailbox is invalid. It
must be a sequence of between one and 18 digits."

After you acknowledge the error message, input focus is moved to the
mailbox text field.

Password validity The password must be that of an administrator on
the CallPilot network authority with at least Directory Synchronization
Administration rights. The password cannot be blank, and it cannot contain
spaces. The password characters entered are displayed as "*".

Attribute modification tab
The tab that configures attribute modification contains check boxes
that specify which CND attributes are modified during CallPilot GAB
synchronization. See Figure 33 "CallPilot GAB Synchronization Job dialog
Attribute modification tab" (page 126)
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Figure 33
CallPilot GAB Synchronization Job dialog Attribute modification tab

The check boxes determine the CND attributes that are modified during
CallPilot GAB synchronization. For example, suppose that Telephony
Manager has added many subscribers to CND and the network
administrator does not want those subscriber name attributes overwritten by
their values in CallPilot during GAB synchronization. Therefore, the network
administrator deselects the check box on the name attributes.

ATTENTION
If the CND mail attribute is not modified, IMAP-compatable clients can not use
the CallPilot Global Address Book. They must continue to use their existing local
address books.

Entry cleaning tab
The entry cleaning tab contains radio buttons that you select to
determine how CND subscriber entries are cleaned during CallPilot GAB
synchronization. See "Cleaning phase" (page 118).
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Figure 34
CallPilot GAB Synchronization Job dialog Entry Cleaning tab

Exactly one of the two entry cleaning radio buttons can be selected at any
given time.

If a previous CallPilot GAB synchronization job has been saved, the saved
value is pre-populated as the entry cleaning default. Otherwise, the first
radio button is selected.

Logging tab
The tab that configures logging contains a check box that specifies whether
transaction logging occurs during CallPilot GAB synchronization. See
Figure 35 "CallPilot GAB Synchronization Job Logging tab" (page 127)

Figure 35
CallPilot GAB Synchronization Job Logging tab
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The check box determines whether transaction logging is enabled.

If a previous CallPilot GAB synchronization job has been saved, the saved
value is pre-populated as the transaction logging default. Otherwise,
transaction logging is disabled.

CallPilot GAB progress dialog
The CallPilot GAB Progress dialog monitors the progress of a running
synchronization job. The following statistics are monitored:

• the number of entries synchronized and cleaned

• the number of entries that have failed to synchronize and be cleaned

• a message

• a progress bar

The dialog also contains buttons that:

• cancel the synchronization

• close the dialog

ATTENTION
CallPilot synchronization is underway as soon as the progress dialog opens.
There is no Start button.

Figure 36
CallPilot GAB Synchronization progress dialog
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Statistics
The statistics fields display the total number of entries for all CallPilot hosts.
Users can view these statistics for each CallPilot host in the summary log
when the job is complete. See "Summary log file" (page 119).

Cancel button
The cancel button is initially the only button that is enabled. When clicked,
the following events occur:

• the synchronization job is cancelled

• the cancel button is disabled

• the close button is enabled

ATTENTION
No changes are rolled back after cancellation. For example, entries that have
already been synchronized maintain the changes made to them that took place
prior to cancellation. Also, if cancellation occurs during the synchronization
phase, no entry cleaning occurs

ATTENTION
There is no way to restart or continue the synchronization from within the progress
dialog once the job is cancelled. After cancellation, the only option is to close the
progress dialog.

Close button
The close button is initially disabled. It is only enabled when you manually
cancel the synchronization or the synchronization completes normally.
When clicked, the progress dialog is closed.

CallPilot GAB Synchronization Procedures
Procedures in this section are:

• Launching the CallPilot GAB synchronization job. See Procedure 37
"Launching the CallPilot GAB synchronization job" (page 130).

• Defining the CallPilot GAB synchronization job. See "Defining the
CallPilot GAB synchronization job" (page 130)

• Saving the CallPilot GAB synchronization job. See "Saving the CallPilot
GAB synchronization job" (page 131)

• Running the CallPilot GAB synchronization job. See Procedure 40
"Running the CallPilot GAB synchronization job manually" (page 132)

• Scheduling the CallPilot GAB synchronization job . See "Scheduling the
CallPilot GAB synchronization job" (page 134)
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Launching the CallPilot GAB synchronization job
To launch the CallPilot GAB synchronization job, see Procedure 37
"Launching the CallPilot GAB synchronization job" (page 130).

Procedure 37
Launching the CallPilot GAB synchronization job

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Subscriber synchronization > CallPilot Global
Address Book synchronization....

The CallPilot Global Address Book Synchronization
screen appears (see Figure 37 "CallPilot Global Address Book
Synchronization" (page 130)).

Figure 37
CallPilot Global Address Book Synchronization

—End—

Defining the CallPilot GAB synchronization job
To define the CallPilot GAB synchronization job, see Procedure 38 "Defining
the CallPilot GAB synchronization job" (page 131).
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Procedure 38
Defining the CallPilot GAB synchronization job

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Subscriber Synchronization > CallPilot Global
Address Book Synchronization.

3 Click the Network Authority tab of the CallPilot GAB
Synchronization dialog box, provide values for the network authority
fields. See "Network authority tab" (page 124).

4 Select the Save Password check box if you want the password to
be remembered.

5 Click the Attribute Modification tab of the CallPilot GAB
Synchronization dialog box, select the CND attributes that are to
be modified by the synchronization job. See "Attribute modification
tab" (page 125).

6 Click the Entry Cleaning tab of the CallPilot GAB Synchronization
dialog box, select how CND subscriber entries are to be cleaned.
See "Entry cleaning tab" (page 126).

7 Click the Logging tab of the CallPilot GAB Synchronization dialog
box, select whether transaction logging is to occur. See "Logging
tab" (page 127).

8 Click Save.

—End—

Saving the CallPilot GAB synchronization job
To save the CallPilot GAB synchronization job, see Procedure 39 "Saving
the CallPilot GAB synchronization job" (page 131).

Procedure 39
Saving the CallPilot GAB synchronization job

Step Action

1 If it is not already open, open the CallPilot GAB Synchronization
dialog box. See "Passwords" (page 121)
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2 On the Network Authority tab of the CallPilot GAB Synchronization
dialog box, select whether the network authority password is to be
saved.

ATTENTION
Note that scheduled GAB synchronization cannot be performed until the
GAB synchronization job has been defined and saved (including the
network authority password).

3 In the CallPilot Global Address Book Synchronization dialog
box, either:

• Click Save to save the job.

or

• Select File > Save to save the job.

4 If prompted, click Yes to save the changes.

5 Click Close to close the CallPilot Global Address Book
Synchronization dialog box.

—End—

Running the CallPilot GAB synchronization job
To manually run the CallPilot GAB synchronization job, see Procedure 40
"Running the CallPilot GAB synchronization job manually" (page 132)

Procedure 40
Running the CallPilot GAB synchronization job manually

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Subscriber Synchronization > CallPilot Global
address Book Synchronization.

3 In the CallPilot GAB Synchronization dialog box, either

• Click Run

or

• Select File > Run

The CallPilot GAB Synchronization Progress dialog appears.
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Regardless of how the job is run, the following events occur:

• The values in the host, VPIM prefix, and mailbox fields are
checked for validity in that order. If any of the fields contain
invalid values, an error dialog is displayed and input focus is
moved to the field in error. Note that even if more than one of the
fields contains an invalid value, only one error dialog is displayed:
for the first field in error.

• If all field values are valid, the tool displays the progress dialog
and starts synchronization. If synchronization can not start (for
example, because the network authority details are incorrect),
the "Failed to start synchronization job." error message dialog
appears.

ATTENTION
Running the synchronization job does not automatically save the
information entered into the dialog.

The password is only saved if the Save password check box is
selected. When selected, the password is encrypted before it is
saved. If the password is not saved, it has a blank default value
the next time the tool runs.

ATTENTION
If the correct password is not saved, scheduled CallPilot GAB
synchronization cannot be performed.

4 Click Save on the CallPilot Global address Book Synchronization
screen.

or

Click File > Save on the menu bar.

When either action is taken, the information in the dialog is saved
so that the fields are pre-populated the next time the CallPilot GAB
synchronization tool is run.

5 Click Close when the progress bar shows the job is completed and
you have reviewed the information on the screen.

If there are any unsaved changes, the Save dialog screen appears,
asking "Do you want to save the changes to this synchronization
job?".

—End—
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Scheduling the CallPilot GAB synchronization job

ATTENTION
Scheduled GAB synchronization cannot be performed until the GAB
synchronization job has been defined and saved (including the password). See
the procedures in sections"Defining the CallPilot GAB synchronization job" (page
130) and "Saving the CallPilot GAB synchronization job" (page 131).

To schedule CallPilot GAB synchronization to occur at same time in the
future, see Procedure 41 "Scheduling the CallPilot GAB synchronization
job" (page 134).

Procedure 41
Scheduling the CallPilot GAB synchronization job

Step Action

1 Open the Windows Control Panel.

• On Windows XP, select Start > Control Panel.

• On Windows Server 2003, select Start, right-click Control Panel
and select Open.

• On Windows 2000 and Windows 2000 Server, select Start >
Settings > Control Panel.

2 Double-click the Scheduled Tasks shortcut.

3 In the Scheduled Tasks explorer, double-click Add Scheduled Task
to display a welcome dialog.

4 In the welcome dialog, click Next to display a dialog in which to
select the program to schedule.
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Figure 38
Add Scheduled Task: Program dialog

5 In the program dialog, click Browse to open a file chooser.

6 Browse to the CND installation folder and select the
runCallPilotGabSync.jar file.

7 Click Open to open a task name and frequency dialog.

8 Enter the task name and select when CallPilot GAB synchronization
is to occur (either daily, weekly, monthly, or one time only). Note
that CallPilot GAB synchronization can not be scheduled to occur
for the choices when my computer starts or when I log on. Do
not select either of those choices

9 Click Next to open a start time and date dialog.

10 Enter information to indicate when CallPilot GAB synchronization
is to occur.

11 Click Next to open a user dialog.

12 Enter the user name and password of the Windows account
under which CallPilot GAB synchronization is going to run. See
"Passwords" (page 121) for an explanation of CallPilot GAB
passwords.

13 Click Next to open a summary dialog.
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14 In the summary dialog, select the check box to open advanced
properties.

15 Click Finish to open an advanced properties dialog.

Figure 39
Add scheduled task: Advanced options dialog

16 Edit the Run field to be exactly as follows (noting that case is
significant).
javaw -jar runCallPilotGabSync.jar

17 Click Apply to apply the changes and open a dialog prompting for
account information.

18 Enter the account information as in step 12.

19 Click OK to close the account dialog.

20 Click OK to close the Add Scheduled Task dialog.
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At the date and time the task is scheduled to run, the CallPilot GAB
Synchronization Progress dialog box appears and synchronization
begins.

—End—
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CSV Subscriber Export

Contents
This section contains information on the following topics.

• "Introduction" (page 139)

• "Exported attributes" (page 139)

• "Exporting CSV subscriber data" (page 141)

• "Error Handling" (page 143)

Introduction
The Comma Separated Values (CSV) Subscriber Export feature allows
administrators to export subscriber records from Common Network Directory
(CND) to a CSV file. This feature is limited to exporting subscribers (in
other words, any entry in the ou=Subscribers container in CND that has
an objectclass value of ‘nortelSubscriber’). All subscribers in CND are
exported during an export.

Exported attributes
A fixed set of attributes for each subscriber is exported (see Table 9
"Supported subscriber attributes in CND export tool" (page 139)).

Table 9
Supported subscriber attributes in CND export tool

Column CND Attribute Description Syntax

1 entryUUID Entry’s unique identifier UUID

2 givenName Official First Name DirectoryString

3 initials Official Middle Name DirectoryString

4 sn Official Last Name DirectoryString

5 preferredName Preferred Name DirectoryString

6 subscriberType Type DirectoryString

7 officeLocation Location DirectoryString
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8 roomNumber Room Number DirectoryString

9 serviceStartDate Service Start Date DirectoryString

10 serviceEndDate Service End Date DirectoryString

11 preferredLanguage Language DirectoryString

12 postOfficeBox Post Office Box DirectoryString

13 street Street No DirectoryString

14 l City DirectoryString

15 st Province/State DirectoryString

16 country Country DirectoryString

17 postalCode Postal Code/Zip DirectoryString

18 mail Email IA5 String

19 preferredDirectoryNumber Preferred DN DirectoryString

20 preferredEsnTelephoneNumber Preferred ESN DirectoryString

21 preferredExternalTelephoneNumber Preferred External DN DirectoryString

22 facsimileTelephoneNumber Fax Facsimile
Telephone Number

23 homePostalAddress Home Address TelephoneNumber

24 homePhone Home Phone TelephoneNumber

25 mobile Mobile Phone TelephoneNumber

26 pager Pager TelephoneNumber

27 o Company DirectoryString

28 employeeNumber Employee Number DirectoryString

29 description Description DirectoryString

30 title Job Title DirectoryString

31 departmentNumber Department number DirectoryString

32 preferredExtension Preferred Extension DirectoryString

33 subMgrTaskStatus Subscriber Manager
task status

DirectoryString

34 billingAccountCode Billing account code DirectoryString

35 billingAuthorizationCode Billing authorization
code

DirectoryString

36 cpndName Call Party Name
Display name

DirectoryString
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File Format
The first row in the exported CSV file is the file header, and contains the
CND attribute names for the exported attributes. A complete list of the
attribute names is shown in Table 9 "Supported subscriber attributes in
CND export tool" (page 139). Each row in the file is a complete record, with
attribute values corresponding to the attribute names in the header row. If
a value does not exist for an attribute, none is given in the file, and this is
represented with no characters. A simple example is shown in Figure 40
"Example of CSV export file" (page 141). Note that all attributes are not
visible in the figure.

Figure 40
Example of CSV export file

The file created by CSV subscriber export conforms to the Microsoft CSV
format when exporting subscribers. For a detailed discussion of Standard
and Microsoft CSV formats see Appendix "CSV File Format" (page 191).

File encoding
Files written by the CSV export feature are encoded using 8-bit Unicode
Transformation Format (UTF-8) and include the Unicode byte-order mark
(see Appendix "Unicode byte-order mark" (page 197)) to indicate the file’s
encoding. This allows exported CSV files to be modified and then properly
read by the CSV synchronization feature.

Exporting CSV subscriber data
To export subscriber data from CND see Procedure 42 "Exporting
subscribers from CND" (page 142).
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Procedure 42
Exporting subscribers from CND

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > CSV subscriber export... .

The CSV subscriber export screen appears (see Figure 41 "CSV
subscriber export dialog " (page 142)).

Figure 41
CSV subscriber export dialog

3 Choose a directory that you would like the export file to be located in
(#1 in Figure 41 "CSV subscriber export dialog " (page 142)).

4 Enter a filename to export the subscribers to (#2 in Figure 41 "CSV
subscriber export dialog " (page 142)).

5 Click Export to start the export (#3 in Figure 41 "CSV subscriber
export dialog " (page 142)).

The CSV subscriber export progress dialog indicates that the export
is in progress.

6 Click OK to close the progress dialog when the CSV subscriber
export dialog indicates that the export is completed .
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—End—

Error Handling
Table 10 "Handled error conditions" (page 143) shows how error conditions
are handled:

Table 10
Handled error conditions

Error condition System response

You select an existing file as the target. A confirmation dialog is displayed,
asking if you want to replace the file.

You select a file without an extension,
and when the .csv extension is
appended to the file, the resulting file
exists.

A confirmation dialog is displayed,
asking you if you want to replace the
file.

The connection to the CND service is
lost after the export has started.

A standard error dialog is displayed.
The text on the dialog is:
Unable to export to <filename>.

The connection to the CND service is
unavailable.

A standard error dialog is displayed.
The text on the dialog is:
The export to <filename> could not
start.

The system is unable to complete the
export operation. For example, the
system is out of disk space or the CND
service is lost after the export has
started.

A standard error dialog is displayed.
The text on the dialog is:

Unable to export to <filename>.

ATTENTION
If the system is unable to complete the export operation for any reason, a CSV file
is not created, even if one with partial results could be created.

For detailed CND troubleshooting information see Appendix "CND
Troubleshooting" (page 155).
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Nortel Schema Upgrade

Contents
This section contains the following topics:

• "Introduction" (page 145)

• "Backward-compatibility" (page 145)

• "Schema Downgrading" (page 145)

• "Schema validation" (page 146)

• "Error conditions" (page 147)

Introduction
Nortel schema upgrade provides the ability to upgrade the Common
Network Directory (CND) Nortel schema. It is necessary to upgrade the
CND schema when Nortel applications require new schema elements.

Backward-compatibility
All Nortel schema releases are completely backward-compatible.
Applications that require a CND Nortel schema to be at a specific version
are completely operational if the CND Nortel schema is at that version or
any subsequent version.

Schema Downgrading
Schema downgrading refers to the upgrading of the Nortel schema to a
lesser version than the one currently installed on the system. For example,
upgrading to Version 3 when you are currently running Version 5. Schema
downgrading is not supported since it may invalidate objects stored in CND.

Implications to backup and restore
To protect against inadvertent schema downgrading, you cannot restore a
backup file containing data tied to a newer version of CND schema than the
one that is currently installed on the system. Nortel recommends that a
backup operation be performed immediately after a schema upgrade, and
all previous backup files be archived.
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Schema validation
The Nortel schema upgrade tool validates the user-supplied schema
file prior to attempting to perform a schema upgrade. A schema file is
considered invalid for either of the following reasons:

• It is not a genuine Nortel schema file.

• It is a genuine Nortel schema file, but the file has been modified.

To upgrade theCND Nortel schema, perform the following steps:

Procedure 43
Upgrading the Nortel schema

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Tools > Nortel schema upgrade.

The Upgrade dialog box appears (see Figure 42 "Nortel schema
upgrade" (page 146)).

Figure 42
Nortel schema upgrade

3 Navigate to the directory with the Nortel Schema files.
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4 Select the Nortel Schema file that you want to use for the upgrade
(see Figure 43 "Nortel schema file dialog box" (page 147)).

Figure 43
Nortel schema file dialog box

5 Click Upgrade.

6 Click Yes to confirm the schema upgrade.

OR

Click No to cancel the schema upgrade.

7 The Schema upgrade process dialog displays during the schema
upgrade.

At the end of the upgrade process, the Schema Upgrade Progress
dialog indicates that the job is complete.

8 Click OK to close the dialog.

—End—

Error conditions
The following section discusses how the Nortel schema upgrade feature
handles the following error conditions:

• Invalid schema file

• Invalid upgrade schema version
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• Other error conditions

Invalid schema file
If a Nortel schema file is corrupted for any reason, it cannot be selected for
upgrade by the system. An error message indicates that the schema file is
invalid.

Invalid upgrade schema version
The system does not allow a Nortel schema file to be selected that would
cause a downgrade (see "Schema Downgrading" (page 145)).

An error message indicates that the schema version is invalid.

Other errors
If a schema upgrade operation fails for any reason not mentioned in the
previous sections, such as a problem stopping or starting the CND service,
a general error message is displayed.
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Version Information

Contents
This section contains the following topics:

• "Introduction" (page 149)

• "Current version information" (page 149)

Introduction
This section shows you how to locate the current Common Network
Directory (CND) version.

Current version information
The version of CND currently in use is displayed under Show CND Version,
located in the CND Manager Start menu folder. When it is launched, a
DOS command window appears that displays the CND version currently
being used. There are two ways to determine the version of CND Manager
that is installed:

• Procedure 44 "Verifying version information using CND Manager" (page
149)

• Procedure 45 "Verifying version information from Microsoft OS" (page
150)

Procedure 44
Verifying version information using CND Manager

Step Action

1 Launch CND Manager. See Procedure 9 "Launching CND Manager"
(page 42).

2 Select Help > About CND Manager.

The About CND Manager page appears.

Information on this page includes:

• Release
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• Build Number

• Schema Version

3 Click OK to close the window.

—End—

Procedure 45
Verifying version information from Microsoft OS

Step Action

1 Select Start > All Programs > Common Network Directory >
Show CND Version in the Windows OS.

The Show CND version window appears.

The CND version information on the screen includes CND release
number, build number, and schema version

2 Hit any key to close the window.

—End—
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Clearing Configuration of TLS
Certificates

Contents
This section contains the following topics:

• "Introduction" (page 151)

• "Clearing TLS/SSL certificates" (page 151)

Introduction
Configuring invalid Transaction Layer Security/Secure Socket Layer
(TLS/SSL) encryption certificates in Common Network Directory (CND)
Manager renders the CND service unreachable. During the configuration of
the TLS/SSL encryption certificates in CND Manager, the certificates are not
validated until the configuration settings are applied and the CND service is
restarted. If certificates are invalid, the CND service does not restart.

Suppose the administrator were to do the following:

The administrator selects an invalid server certificate, key file or
Certificate Authority (CA) certificate, using the Privacy Settings tab in
CND Manager, under the Files for TLS/SSL Encryption group box and
then clicks OK. The system asks if the administrator wants the service
to automatically be restarted. However, the CND service restart fails
and CND Manager closes. The administrator cannot log on to CND
Manager again to fix the selected invalid certificate files because the
CND service is not running.
In this case, an error dialog appears, stating "Unable to login. Ensure
the CND service is running and try again." If you encounter this warning
when you log on, use Procedure 46 "Clearing TLS/SSL encryption
certificate configuration" (page 152) to fix the problem.

Clearing TLS/SSL certificates
With CND 2.2, you can remove the configuration of all TLS/SSL encryption
certificates using the Clear configuration of CND Manager’s TLS certificates
tool.
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If the configuration of all encryption certificates is cleared:

• Certificates are not deleted. Only CND configuration is updated not to
use encryption certificates.

• CND does not start on the secure TLS/SSL port

Procedure 46
Clearing TLS/SSL encryption certificate configuration

Step Action

1 From the Windows Start menu, select All Programs > Nortel >
Common Network Directory > Clear configuration of CND
Manager’s TLS certificates.

Figure 44
Clearing TLS/SSL encryption certificate configuration

2 At the prompt (shown in Figure 45 "Clear all TLS/SSL encryption
certificates confirmation" (page 153)), type Y or y and press
Enter to clear TLS/SSL certificate configuration. Once certificate
configuration is cleared, CND does not start on the secure TLS/SSL
port.

Selecting this option automatically enables the "Listen on
unencrypted port only" option and disables other port encryption
options.

or

Type N or n and press Enter to close the utility without clearing the
TLS/SSL certificate configuration.
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Figure 45
Clear all TLS/SSL encryption certificates confirmation

3 Start the CND service. See Procedure 47 "Starting the CND Service
manually" (page 153).

—End—

Procedure 47
Starting the CND Service manually

Step Action

1 Select Start > All Programs > Administrative Tools > Services in
the Windows OS.

2 Right-click Nortel Common Network Directory Service .

3 Select Start or Restart on the context menu.

The Windows Service Control Manager displays a progress bar
while the CND service starts.

After the CND service starts successfully, the Service Control
window closes, and the service status is updated to "Started" in
the Services window.

If the CND Service has been started, the Start option will be disabled
on the context menu and the service status will show as "Started".

—End—
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Appendix A
CND Troubleshooting

This chapter provides detailed information for troubleshooting CND. The
following topics are covered:

• "Logging" (page 155)

• "The CND service does not start" (page 157)

• "Configuring the CND Manager service interaction" (page 161)

• "Synchronization problems" (page 164)

• "Idle connection timeout configuration" (page 164)

• "Manual CND removal" (page 165)

Logging
Much information is logged to files on a server with a running Common
Network Directory (CND). Those log files are divided into the following
categories:

• log files created by the OpenLDAP directory service

• log files created by CND Manager

OpenLDAP log files
The OpenLDAP directory service’s log file is openldap.log, which
is stored in CND’s installation folder (C:\Program Files\Nortel\Common
Network Directory by default). You can control the information that is placed
into openldap.log using CND Manager. Using CND Manager, you can
select none, or one or more of the following OpenLDAP logging options:

• trace function calls

• debug packet handling

• heavy trace debugging

• connection management

• print out packets sent and received
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• search filter processing

• configuration file processing

• access control list processing

• stats log connections/operations/results

• stats log entries sent

• print communication with shell backends

• entry parsing

CND Manager log files
Log files created by CND Manager are divided into the following categories:

• main log file

• Lightweight Directory Access Protocol (LDAP) synchronization log files

Main log file
The main CND manager log file is a rotating set of files stored in the log
folder within CND’s installation folder. When viewing CND Manager log files,
it is important to note the timestamp on each file to ensure you view the
most recently logged information.

Using a rotating set of files provides the benefit of ensuring that the most
recent information is logged while also capping the disk space that log files
can occupy.

File names
Each log file is named cndManagerX.Y.log, where X is a digit starting
at zero used to distinguish the rotating set of files and Y is used to resolve
conflicts that occur if the log file is in use by other applications when CND
Manager attempts to write to it. For example, if cndManager0.0.log
is locked because it is open in a text editor, CND Manager automatically
creates cndManager0.1.log and logs its information there.

Log file contents
CND Manager log files are in text format and each logged event writes a
new record. Records contain the following information:

• the date and time the event occurred

• the Java class and method that caused the event to be logged

• event details
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The event details vary depending on the type of event. The details can
be as simple as a message (for example, the Java Runtime Engine (JRE)
version used to launch the CND Manager JAR file) or as complicated as a
complete stack trace with source code line numbers (when a Java exception
is logged).

CND Manager log files are best read in a simple text editor, such as
Microsoft WordPad.

The CND service does not start
To recover a CND system whose service does not start see Procedure 48
"Recovering a CND system whose service does not start" (page 157):

Procedure 48
Recovering a CND system whose service does not start

Step Action

1 Try to recover a corrupted database (see "Recovering a corrupted
database" (page 157)).

2 Try to start the service from the command line and turn on all
debugging (see "Starting service from command line" (page 158)).

3 Try to display database statistics (see "Displaying service statistics"
(page 159)).

—End—

Recovering a corrupted database
db_recover is a tool that is used to recover a corrupted database. CND
installs the tool directly into its installation folder. The tool has no effect on
a database that is not corrupted.

The tool is only useful when the CND service is stopped. To make absolutely
certain that the CND service is stopped see Procedure 49 "Ensuring the
CND service is stopped" (page 157):

Procedure 49
Ensuring the CND service is stopped

Step Action

1 Change the CND service startup type to "manual" (see Procedure
50 "Changing the CND service startup type to manual" (page 158)).

2 Reboot the machine on which CND is installed.
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—End—

Procedure 50
Changing the CND service startup type to manual

Step Action

1 Go to Start > All Programs > Administrative Tools > Services in
the Windows OS.

2 Right-click on Nortel Common Network Directory.

3 Select Properties.

4 On the General tab, under Startup type, choose Manual.

—End—

To run the db_recover tool see Procedure 51 "Running the db_recover
tool" (page 158).

Procedure 51
Running the db_recover tool

Step Action

1 Open a command window.

2 Change directory to CND’s installation folder (by default, "C:\Program
Files\Nortel\Common Network Directory").

3 Run the following command: db_recover -h data.

—End—

If the tool runs without error, it has no output. Even if the tool runs without
error, the CND service does not necessarily start. After running the tool, try
to manually start the CND service. If you are able to manually start the CND
service, ensure you change the service’s startup type to "automatic".

Starting service from command line
To start the service from the command line see Procedure 52 "Starting the
service from command line" (page 159):
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Procedure 52
Starting the service from command line

Step Action

1 Open a command window.

2 Change directory to CND’s installation folder (by default, "C:\Program
Files\Nortel\Common Network Directory").

3 Run the following command: slapd -d 1.

—End—

The -d 1 switch enables debugging and causes a lot of information to be
output to the console. To help the CND design team debug the problem,
you can direct the command’s output to a file as follows: slapd -d 1 >
outputFile.txt.

Reinstalling application files
If CND continues to fail, you can repair a corrupted file or a file deleted by
mistake. See "Repair" (page 33).

Verifying the Host Server IP configuration
Verify the Host Server IP configuration by entering ipconfig /all in
the command line window.

Verifying base network connectivity to LDAP or CallPilot Host Servers
Verify base network connectivity to LDAP or CallPilot Host Servers by
entering ping <address or Hostname> in the command line window.

Displaying service statistics
db_stat is a tool that is used to print out database statistics. CND installs
the tool directly into its installation folder.

To run the db_stat tool see Procedure 53 "Running the db_stat tool"
(page 159):

Procedure 53
Running the db_stat tool

Step Action

1 Open a command window.

2 Change directory to CND’s installation folder (by default, "C:\Program
Files\Nortel\Common Network Directory").
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3 Run the following command: db_stat -c -h data.

—End—

The tool’s output is as follows:

D:\Program Files\Nortel\Common Network Directory>db_stat
-c -h data

101 Last allocated locker ID.

2147M Current maximum unused locker ID.

9 Number of lock modes.

1000 Maximum number of locks possible.

1000 Maximum number of lockers possible.

1000 Maximum number of lock objects possible.

10 Number of current locks.

62 Maximum number of locks at any one time.

30 Number of current lockers.

33 Maximum number of lockers at any one time.

10 Number of current lock objects.

62 Maximum number of lock objects at any one time.

1095970 Total number of locks requested.

1095960 Total number of locks released.

0 Total number of lock requests failing because
DB_LOCK_NOWAIT was set.

0 Total number of locks not immediately available
due to conflicts.

0 Number of deadlocks.

0 Lock timeout value.

0 Number of locks that have timed out.

0 Transaction timeout value.

0 Number of transactions that have timed out.

360KB The size of the lock region.

0 The number of region locks granted after waiting.

1201311 The number of region locks granted without
waiting.

After running the tool, try to manually start the CND service.
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Configuring the CND Manager service interaction
The Windows service handling API (described in detail on the Microsoft
Software Developer Network, or MSDN) is asynchronous in nature. This
impacts CND because there are several instances where CND Manager
requires the CND service be in a particular state. For example, a backup
operation cannot proceed until the CND service is actually stopped (not only
when CND Manager asks Windows to stop the service).

To deal with the Windows API behavior, CND Manager uses polling
to ascertain the actual status of the CND service. On most systems,
CND Manager’s default polling configuration is sufficient, and no service
interaction problems occur. On some systems, however, the default
configuration is not enough.

CND Manager has two ways to help with service handling:

• logging service failures

• configuration

Logging service failures
Service failures are logged in a file named "serviceFailures.txt" in the CND
installation folder (C:\Program Files\Nortel\Common Network Directory by
default). This file contains one multi-line entry for each service failure. Each
entry contains:

• a description of what failed (for example, "Spawn start attempt" or
"Spawn stop attempt")

• the attempt number of the failure

• the date and time of the failure

• an error code

• the traceback of the code that caused the failure

For example, an entry in the log file might be:

Spawn stop attempt 2 failed at Tue Oct 17 12:39:23 EDT 2006: 51061

java.lang.Thread.dumpThreads(Native Method)

java.lang.Thread.getStackTrace(Unknown Source)

com.nortel.openldap.servermgr.ServiceMgrImpl.logFailure(ServiceMgrImpl.ja
va:357)

com.nortel.openldap.servermgr.ServiceMgrImpl.logSpawnServiceStopFailur
e(ServiceMgrImpl.java:319)

com.nortel.openldap.servermgr.ServiceMgrImpl.spawnServiceStopProcess(Serv
iceMgrImpl.java:178)
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com.nortel.openldap.servermgr.ServiceMgrImpl.ensureServiceIsStopped(Servi
ceMgrImpl.java:207)

com.nortel.openldap.servermgr.backuprestore.BackupRestoreMgrImpl.generate
LdifFile(BackupRestoreMgrImpl.java:292)

com.nortel.openldap.servermgr.backuprestore.BackupRestoreMgrImpl.backup(B
ackupRestoreMgrImpl.java:176)

com.nortel.cndmgr.ui.MainFrame.backupMenuItemActionPerformed
(MainFrame.java:1104)

com.nortel.cndmgr.ui.MainFrame.access$3500(MainFrame.java:74)

com.nortel.cndmgr.ui.MainFrame$36.actionPerformed(MainFrame.java:638)

javax.swing.AbstractButton.fireActionPerformed(Unknown Source)

javax.swing.AbstractButton$Handler.actionPerformed(Unknown Source)

javax.swing.DefaultButtonModel.fireActionPerformed(Unknown Source)

javax.swing.DefaultButtonModel.setPressed(Unknown Source)

javax.swing.AbstractButton.doClick(Unknown Source)

javax.swing.plaf.basic.BasicMenuItemUI.doClick(Unknown Source)

javax.swing.plaf.basic.BasicMenuItemUI$Handler.mouseReleased(Unknown
Source)

java.awt.Component.processMouseEvent(Unknown Source)

javax.swing.JComponent.processMouseEvent(Unknown Source)

java.awt.Component.processEvent(Unknown Source)

java.awt.Container.processEvent(Unknown Source)

java.awt.Component.dispatchEventImpl(Unknown Source)

java.awt.Container.dispatchEventImpl(Unknown Source)

java.awt.Component.dispatchEvent(Unknown Source)

java.awt.LightweightDispatcher.retargetMouseEvent(Unknown Source)

java.awt.LightweightDispatcher.processMouseEvent(Unknown Source)

java.awt.LightweightDispatcher.dispatchEvent(Unknown Source)

java.awt.Container.dispatchEventImpl(Unknown Source)

java.awt.Window.dispatchEventImpl(Unknown Source)

java.awt.Component.dispatchEvent(Unknown Source)

java.awt.EventQueue.dispatchEvent(Unknown Source)

java.awt.EventDispatchThread.pumpOneEventForFilters(Unknown Source)

java.awt.EventDispatchThread.pumpEventsForFilter(Unknown Source)

java.awt.EventDispatchThread.pumpEventsForHierarchy(Unknown Source)

java.awt.EventDispatchThread.pumpEvents(Unknown Source)
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java.awt.EventDispatchThread.pumpEvents(Unknown Source)

java.awt.EventDispatchThread.run(Unknown Source)

In this case, attempt #2 to spawn a stop attempt failed with an error code
of 51061. This occurred during a backup attempt, which is apparent from
the traceback.

Configuration
As of CND 2.1.87 (build 02.10.00.87), users can configure four values
related to how CND Manager interacts with the CND service:

• how many attempts are made to start the CND service before giving up

• the delay between each start attempt

• how many attempts are made to stop the CND service before giving up

• the delay between each stop attempt

ATTENTION
The configuration of these values should be used for troubleshooting only.

The configuration options are specified using Java Virtual Machine
(JVM) system properties, which can be assigned when launching the
CND Manager JAR file (cndManager.jar). "System properties" (page
163)provides a list of the system properties, descriptions, and default values.

System properties

Property name Description Default
value

NUM_START_ATTEMPTS configures how many start attempts are
made before CND Manager gives up

100

START_DELAY configures the number of milliseconds
between each start attempt

750

NUM_STOP_ATTEMPTS configures how many stop attempts are
made before CND Manager gives up

100

STOP_DELAY configures the number of milliseconds
between each stop attempt

500

Use Procedure 54 "Configuring CND Manager for number and interval
of attempts" (page 164)to configure that CND Manager should try 200
start attempts before giving up and delay 625 milliseconds between each
attempt:
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Procedure 54
Configuring CND Manager for number and interval of attempts

Step Action

1 Open a DOS command window.

2 Change directory to the CND installation folder (C:\Program
Files\Nortel\Common Network Directory by default).

3 Issue the following command: java -DNUM_START_AT-
TEMPTS=200 -DSTART_DELAY=625 -jar cndManager.jar

—End—

If the properties are given non-integral values, they revert to their default
values. Other than that check, there is no other checking on the values. For
example, if a user were to specify lower values for any of the properties,
CND Manager may not work as expected. This could manifest itself in a
number of ways not limited to failed backups, failed restores, and failed
schema upgrades.

Synchronization problems
To correct LDAP synchronization problems, see "LDAP Subscriber
Synchronization" (page 75).

To correct CallPilot synchronization problems, see "CallPilot Global Address
Book Synchronization" (page 117).

Idle connection timeout configuration
As with all servers, CND only supports a certain number of active
connections. When client applications create a connection to CND but do
not properly close that connection, it becomes idle. Normally, this is not a
problem. However, when many connections aren’t properly closed, the
CND’s OpenLDAP server eventually gets bogged down and does not run
properly. When that happens, CND’s database must be manually recovered
using the procedures in "Recovering a corrupted database" (page 157).

In CND 2.1, the default number of seconds to wait before forcibly closing an
idle client connection is 10 seconds.

In CND 2.0, the feature is disabled by default. In other words, idle client
connections are never forcibly closed.

Idle connection timeout is configured in the idletimeout.conf file, which
is in CND’s installation folder (by default, C:\Program Files\Nortel\Common
Network Directory). Note that this file only exists in CND releases that
support idle connection timeout configuration.
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To configure CND’s idle connection timeout see Procedure 55 "Configuring
the CND idle connection timeout" (page 165).

Procedure 55
Configuring the CND idle connection timeout

Step Action

1 Stop the CND service.

2 Open the idletimeout.conf file in a text editor (located in
...Nortel\Common Network Directory file).

3 Edit the line that contains the idletimeout directive.

The numerical value after the directive is the number of seconds
CND waits before forcibly closing an idle client connection. A
numerical value of zero (0) indicates that the feature is disabled. In
other words, when the value is 0, idle client connections are never
forcibly closed.

4 Restart the CND service.

—End—

Note that idle connections are forcibly closed only when new connection
attempts are made. For example, suppose the idle timeout is set to 10
seconds. If there is a connection that remains idle forever, it is not forcibly
closed until a second connection attempt is made.

Manual CND removal
If you are unable to remove CND using Add/Remove Programs in the
Windows control panel, manually remove the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVer-
sion\Uninstall\{1FC12B1E-E8EC-43A2-9698-D0FC0FFE105C}

This procedure is taken from Microsoft’s knowledge base article 314481.

Once the registry key is removed, close any open instances of CND
Manager and manually delete all of the files and subfolders in CND’s
installation folder (C:\Program Files\Nortel\Common Network Directory by
default). Be careful not to delete any needed backup files (in the backup
subfolder) or TLS/SSL certificates (in the certs subfolder).

Once CND has been removed, you can manually reinstall it if desired.
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Appendix B
LDAP background information

Lightweight Directory Access Protocol (LDAP) defines a standard,
message-oriented, extensible protocol for communicating with directory
servers. Initially developed as a gateway to Open Systems interconnect
(OSI) directory services running the X.500 protocol, LDAP has evolved
into a standalone directory service protocol for directories operating on the
lightweight Transport Control Protocol (TCP) stack.

LDAP has the following characteristics:

• Defines a communication protocol.

• Defines the transport and format of messages used by a client to access
data in a directory.

• Operates over the lightweight Transport Control Protocol/Internet
Protocol (TCP/IP) protocol stack.

Common Network Directory (CND) is based on OpenLDAP, an open source
LDAP directory server.

LDAP terms
Organizational Unit (ou)

A container object that is a directory administrative partition. OUs can
contain directory entries of user data or other OUs. Organizational units
enable the delegation of administration to distinct subtrees of the directory.

An example of an OU in a directory is:
"ou=HumanResources,dc=companyAbc,dc=com"

Domain Component (dc)
A directory’s base Distinguished Name (DN) is generally derived from a
company’s Domain Name Server (DNS) domain components. One of the
formats to define a base DN is to split a company’s DNS domain name, for
example "companyAbc.com" into domain components as dc=companyAbc,
dc=com.
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For more information, see "The naming model" (page 168).

for more information about LDAP and LDAP-related terms see Appendix
"LDAP References" (page 179).

The LDAP models
LDAP is most often described in terms of the following models:

• Information Model

• Naming Model

• Functional Model

• Security Model

The models are discussed briefly in the following sections.

The information model
The LDAP information model defines the format of data in a directory server.

The primary unit of data in a directory is an entry. Each entry describes an
object in the server. The type of information that a given entry can contain
is controlled by its schema.

The schema defines the following items:

• Attributes—All entries are comprised of a set of name/value pairs that
are called attributes. For example, an entry representing a person may
have a surname attribute with a value of "Smith".

• Objectclasses—Each entry implements one or more class definitions,
referred to as objectclasses. An objectclass defines the rules for a
particular class of information. For example, an objectclass dictates
attributes that are required in a particular type of entry and attributes
that are optional.

• Syntaxes—Syntaxes define the rules for what is an acceptable value
for a given attribute. Some attributes require their values to be specially
formatted strings, for example, while others require binary values.

• Matching Rules—Matching rules determine what makes a successful
match when searching for an entry in the directory server. Each attribute
has associated matching rules that define its behavior in a search.

The naming model
The LDAP naming model defines the organization of data in a directory
server.
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Data in most directory servers is organized in a tree structure known as
the Directory Information Tree (DIT). Entries are named according to their
location in the DIT by a distinguished name (DN). A DN is composed of the
relative distinguished name (RDN) of each entry in the DIT from the entry
in question to the root. An RDN is an attribute value pair chosen when the
entry is added to the directory, which uniquely identifies the entry at its
level in the DIT. The components of the DN are separated by commas or
semicolons. (Commas are most commonly used.)

Figure 46 "Example of directory information tree" (page 169) illustrates
a simplified DIT.

In the example DIT, labels indicate the RDNs for each entry in the directory.

Figure 46
Example of directory information tree

The DN for the entry "cn=jsmith" is expressed as cn=jsmith, ou=people,
dc=Nortel, dc=com.

The functional model
The LDAP functional model defines the ways in which a directory server
can be utilized by its clients. There are nine supported operations, divided
into three categories, listed below:

1. The interrogation operations:

• Search

• Compare

2. The update operations:

• Add
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• Delete

• Modify

• Modify RDN—this operation is used to modify the special RDN
attribute, as well as to support moving an entry from one location in
the DIT to another

3. The authentication operations:

• Bind

• Unbind

• Abandon—permits the canceling of an operation that is already in
progress

The security model
The LDAP security model defines how clients authenticate themselves to
the directory service and how they are treated after authentication. Privacy
of communication between a client and the server is also supported using
Transport Layer Security / Secure Sockets Layer (TLS/SSL).

Once authenticated, a user’s access to the data in the directory is controlled
by the access control policies configured in the server. LDAP can support
control of access based on the attribute, not just the entry.

Further reading
For more information about LDAP see the following references:

• Understanding and Deploying LDAP Directory Services, Second Edition,
Timothy A. Howes, Mark C. Smith, Gordon S. Good, Addison-Wesley,
2003.

• Understanding LDAP – Design and Implementation, IBM Redbooks,
available at the web at http://publib-b.boulder.ibm.com/red-
books.nsf/RedbookAbstracts/sg244986.html?Open

• LDAP Directories, Marcel Rizcallah, Wiley, 2000.
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Appendix C
Attribute syntax

Though Lightweight Directory Access Protocol (LDAP) supports many
different attribute syntaxes, there are a few common ones used in Common
Network Directory (CND) that need to be understood in order to effectively
interpret the output from Comma Separated Values (CSV) subscriber
export. An understanding of the attribute syntax is also important to any
user wishing to use the CSV subscriber synchronization feature (see "CSV
Subscriber Synchronization" (page 103)).

The following sections describe the most common attribute syntaxes in CND.

NOTE: The latest information on CND attribute syntax is available on CND’s
Twiki site at http://nbvws300.ca.nortel.com/twiki/bin/view.pl/EMS/CndAt-
tributeSyntax.

Audio
RFC 1274 describes the audio syntax as:

( 1.3.6.1.4.1.1466.115.121.1.4 DESC ’Audio String’ )

The Audio attribute type allows the storing of
sounds in the Directory. The attribute uses a
u-law encoded sound file as used by the "play"
utility on a Sun 4. This is an interim format.

Attributes with this syntax store binary data.

DirectoryString
RFC 2252 decscribes the Directory String syntax as:

( 1.3.6.1.4.1.1466.115.121.1.15 DESC ’Directory String’
)
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A string in this syntax is encoded in the UTF-8
form of ISO 10646 (a superset of Unicode). Servers
and clients MUST be prepared to receive encodings
of arbitrary Unicode characters, including
characters not presently assigned to any character
set.

For characters in the PrintableString form, the
value is encoded as the string value itself.

If it is of the TeletexString form, then the
characters are transliterated to their equivalents
in UniversalString, and encoded in UTF-8 [9].

Loosely translated, this means an International Organization for Standards
(ISO) 10646 text string in UCS Transformation 8 (UTF-8) format.

Since Unicode is a vast topic and not widely understood, it is expected
that this definition will be expanded in the future as we learn more about
Unicode in general. Also, restrictions will be added in the future to this
definition as they become apparent.

Facsimile Telephone Number
RFC 2252 decscribes the Facsimile Telephone Number syntax as:

( 1.3.6.1.4.1.1466.115.121.1.22 DESC ’Facsimile
Telephone Number’ )

Values in this syntax are encoded according to the
following BNF:
fax-number = printablestring [ "$" faxparameters ]
faxparameters = faxparm / ( faxparm "$"
faxparameters )
faxparm = "twoDimensional" / "fineResolution" /
"unlimitedLength" /
"b4Length" / "a3Width" / "b4Width" / "uncompressed"
In the above, the first printablestring is the
telephone number, based on E.123 [15], and the
faxparm tokens represent fax parameters.
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Through trial and error, it was discovered that OpenLDAP (and therefore
CND) does not exactly conform to the restrictions outlined in the RFC. For
example, CND allows the following attribute values that are invalid according
to the RFC:

• 6139675027$Hello

• 6139675027$B4Length$Kyle

In CND, attributes with this syntax can store any non-empty string of
characters, with the following restrictions:

• Each character must either be a dollar sign ($) or a character that can
appear in a printable string.

• The string can not begin or end with a dollar sign ($).

Generalized time
RFC 2252 describes the Generalized time syntax as:

( 1.3.6.1.4.1.1466.115.121.1.24 DESC ’Generalized Time’
)

Values in this syntax are encoded as printable
strings, represented as specified in X.208. Note
that the time zone must be specified. It is
strongly recommended that GMT time be used. For
example,

199412161032Z

Through investigation, and trial and error, we have been able to determine
the following additional information on this syntax.

The format can be represented as YYYYMMDDHHMMSS[.n](Z |
(+|-)HHMM)

The format can be divided into the following components:

• the required date component: YYYYMMDD

— YYYY is the year: required

— MM is the month: required

— DD is the day: required

• the required time format, which is in military time: HHMMSS[.n]

— HH is the hour (24 hour military time): required

— MM is the minute: required

— SS is the second: required
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— .n is the fraction of a second: optional

• the required time zone information

— where Z indicates Coordinated Universal Time (UTC); formerly
Greenwich Mean Time (GMT). Note that the Z character is required
only if there is no deviation from UTC. Note that if there is a deviation
from UTC the Z character must be omitted.

— "+" or "-" indicates the direction of the deviation from UTC

— HHMM is the deviation from UTC in hours (HH) and minutes (MM)

Table 11
Generalized time examples

Coordinated Universal Time Generalized time syntax

January 9, 2007 10:24am UTC 20070109102400Z

January 9, 2007 1:12:34pm UTC 20070109131234Z

January 9, 2007 1:12:34pm and 345
milliseconds UTC

20070109131234.345Z

January 9, 2007 1:12:34pm and
one-tenth of a second UTC

20070109131234.1Z

January 9, 2007 at midnight UTC 20070109000000Z

January 9, 2007 10:24am UTC - 5.5
hours

20070109102400-0530

January 9, 2007 10:24am UTC + 10
hours

20070109102400+1000

IA5 String
RFC 2252 describes the IA5 String syntax as:

( 1.3.6.1.4.1.1466.115.121.1.26 DESC ’IA5 String’ )

The encoding of a value in this syntax is the
string value itself.

Attributes with this syntax can store any non-empty string of ASCII
characters.

Numeric String
RFC 2252 describes the Numeric String syntax as:

( 1.3.6.1.4.1.1466.115.121.1.36 DESC ’Numeric String’ )

Example: 1997
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Attributes with this syntax can store any non-empty string, where each
character in the string is either a digit (0-9) or a space (’ ’).

PostalAddress
RFC 2252 describes the Postal Address syntax as:

( 1.3.6.1.4.1.1466.115.121.1.41 DESC ’Postal Address’ )

Values in this syntax are encoded according to the
following BNF:
postal-address = dstring *( "$" dstring )
In the above, each dstring component of a postal
address value is encoded as a value of type
Directory String syntax. Backslashes and dollar
characters, if they occur in the component, are
quoted as described in section 4.3. Many servers
limit the postal address to six lines of up to
thirty characters.

Example:
1234 Main St.$Anytown, CA 12345$USA
\241,000,000 Sweepstakes$PO Box 1000000$Anytown, CA
12345$USA

OpenLDAP does not enforce the suggestions of RFC 2252. Therefore,
attributes with the Postal Address syntax can store exactly the same values
as attributes with the Directory String syntax.

Printable String
RFC 2252 describes the Printable String syntax as:

( 1.3.6.1.4.1.1466.115.121.1.44 DESC ’Printable String’
)

The Printable String syntax is any sequence of the
following English characters:

• a-z (lowercase letters)

• A-Z (uppercase letters)

• 0-9 (digits)

• ’ (single quotation mark)

• ( (open parenthesis)

• ) (close parenthesis)

• + (plus sign)

• , (comma)
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• - (minus sign)

• . (period)

• / (forward slash)

• : (colon)

• ? (question mark)

• (space)

Attributes with this syntax can store any non-empty string of characters,
provided that each character appears in the above list.

TelephoneNumber
RFC 2252 describes the Telephone Number syntax as:

( 1.3.6.1.4.1.1466.115.121.1.50 DESC ’Telephone Number’
)

Values in this syntax are encoded as if they were
Printable String types. Telephone numbers are
recommended in X.520 to be in international form,
as described in E.123 [15].

Example:
+1 512 305 0280

The TelephoneNumber syntax is a string representation of a telephone
number. It is recommended to be in E.123 format. For example,

+1 123 123 1234

OpenLDAP does not enforce the recommendations in RFC 2252. Therefore,
attributes with the Telephone Number syntax can store exactly the same
values as attributes with Printable String syntax.

Telex Number
RFC 2256 describes the Telex Number syntax as:

( 1.3.6.1.4.1.1466.115.121.1.52
1.3.6.1.4.1.1466.115.121.1.50 DESC ’Telex Number’ )
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Values in this syntax are encoded according to the
following BNF:

• telex-number = actual-number "$" country "$"
answerback

• actual-number = printablestring

• country = printablestring

• answerback = printablestring

In the above, actual-number is the syntactic
representation of the number portion of the TELEX
number being encoded, country is the TELEX country
code, and answerback is the answerback code of a
TELEX terminal.

OpenLDAP does not enforce the recommendations in RFC 2256. Therefore,
attributes with the Telex Number syntax can store exactly the same values
as attributes with Facsimile Telephone Number syntax.
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Appendix D
LDAP References

The Common Network Directory (CND) server provides standard
Lightweight Directory Access Protocol (LDAP) Version 3 directory services.
The LDAP protocol (Version 3) is described by the following internet
standards and drafts:

• RFC 2251: Lightweight Directory Access Protocol (v3).

• RFC 2252: Lightweight Directory Access Protocol (v3): Attribute Syntax.

• RFC 2253: Lightweight Directory Access Protocol (v3): UCS
Transformation 8 (UTF-8) String Representation of Distinguished
Names.

• RFC 2254: The String Representation of LDAP Search Filters.

• RFC 2255: The LDAP URL Format.

• RFC 2256: A Summary of the X.500(96) User Schema for use with
LDAPv3.

• RFC 2829: Authentication Methods for LDAP.

Data
CND uses the following standard schema:

• RFC-2256 – Core Schema.

• RFC-1274 – Cosine Schema for support of the inetOrgPerson object
class.

• RFC-2798 – inetOrgPerson (depends on Core schema and Cosine
schema).

Where it is not possible to use standard objects and attributes, CND defines
its own. These take two forms:

• Extensions to existing standard object classes.

• New proprietary objects.
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API
The CND server supports the standard LDAPv3 interface, as described in
RFC-1823, The LDAP Application Programming Interface. Any client that
intends to use CND must utilize the LDAP API to communicate and store
data in CND.

References

Table 12
LDAP references

Ref # Document name Issue #; mm/dd/yyyy

1. RFC 2251:
Lightweight Directory
Access Protocol (v3)

M. Wahl et al.

ftp://ftp.rfc-editor.org/in-notes/rfc2251.txt

December 1997

2. RFC 2252:
Lightweight Directory
Access Protocol
(v3): Attribute Syntax
Definitions

M. Wahl et al.

ftp://ftp.rfc-editor.org/in-notes/rfc2252.txt

December 1997

3. RFC 2253:
Lightweight Directory
Access Protocol
(v3): UTF-8 String
Representation of
Distinguished Names

M. Wahl et al.

ftp://ftp.rfc-editor.org/in-notes/rfc2253.txt

December 1997

4. RFC 2254: The
String Representation
of LDAP Search
Filters

T. Howes

ftp://ftp.rfc-editor.org/in-notes/rfc2254.txt

December 1997

5. RFC 2255: The
LDAP URL Format

T. Howes and M. Smith

ftp://ftp.rfc-editor.org/in-notes/rfc2255.txt

December 1997
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Ref # Document name Issue #; mm/dd/yyyy

6. RFC 2256: A
Summary of the
X.500 User Schema
for use with LDAPv3

M. Wahl

ftp://ftp.rfc-editor.org/in-notes/rfc2256.txt

December 1997

7. RFC 2829,
Authentication
Methods for LDAP

M. Wahl et al.

ftp://ftp.rfc-editor.org/in-notes/rfc2829.txt

May 2000

8. OpenLDAP 2.3.27
Administrators Guide

The OpenLDAP Project

http://www.openldap.org/doc/admin21/

January 2003

9. RFC 1274: The
COSINE and Internet
X.500 Schema

P Barker and S. Kille

ftp://ftp.rfc-editor.org/in-notes/rfc1274.txt

November 1991

10. RFC 2798: Definition
of the inetOrgPerson
LDAP Object Class

M. Smith

ftp://ftp.rfc-editor.org/in-notes/rfc2798.txt

April 2000

11. RFC 1823: The
LDAP Application
Programming
Interface

T. Howes and M. Smith

ftp://ftp.rfc-editor.org/in-notes/rfc1823.txt

August 1995
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Appendix E
Destination folder and files

Installed files
Folders and files are created within the destination folder chosen at
installation. Installed folders and files have the following properties:

• whether they are initially empty

• whether they are overwritten during an upgrade or repair

• whether they are deleted when Common Network Directory (CND) 2.2
is removed

The information in Table 13 "Destination folder subdirectories" (page
183) provides the details of the folders created within the chosen destination
folder.

Table 13
Destination folder subdirectories

Folders within
the Destination
folder

Description of
contents

Is folder
initially
empty?

Are contents
overwritten

during upgrade
or repair?

Are contents
deleted when

CND is
removed?

3rdPartyLicenses third-party licenses No Yes Yes

backup the default folder for
CND backup files

Yes No No

certs Transaction Layer
Security (TLS)
certificate files

Yes No No

data OpenLDAP’s server’s
user data

No No Yes

help CND administration
guide files

No Yes Yes

lib third-party libraries No Yes Yes

log CND Manager log files Yes No Yes
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Folders within
the Destination
folder

Description of
contents

Is folder
initially
empty?

Are contents
overwritten

during upgrade
or repair?

Are contents
deleted when

CND is
removed?

log\LDAP_Sync Lightweight Directory
Access Protocol
(LDAP) Subscriber
Synchronization log
files

Yes No Yes

schema schema files No Yes Yes
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Appendix F
Subscriber attributes

Subscriber attributes
Common Network Directory (CND) extends the "inetOrgPerson" schema
with additional attributes for subscribers. Table 14 "Subscriber attributes in
CND" (page 185) provides a complete list.

Table 14
Subscriber attributes in CND

Attribute Name
Requir

ed? Syntax Object Identifier (OID)

Can be
imported

using CSV
Subscriber
Synchroniz

ation?

Can
store
multip
le valu

es?

audio No 1.3.6.1.4.1.1466.115.121.1.4 No Yes

billingAccountCode No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

billingAuthorizationCode No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

billingWebReportingAcces
sRights

No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

businessCategory No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

carLicense No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

cn Yes 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

combinedName No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

country No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

cpndName No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

departmentNumber No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

description No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

destinationIndicator No 1.3.6.1.4.1.1466.115.121.1.44 Yes Yes

displayName No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

employeeNumber No 1.3.6.1.4.1.1466.115.121.1.15 Yes No
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Attribute Name
Requir

ed? Syntax Object Identifier (OID)

Can be
imported

using CSV
Subscriber
Synchroniz

ation?

Can
store
multip
le valu

es?

employeeType No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

esmGUID No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

facsimileTelephoneNumber No 1.3.6.1.4.1.1466.115.121.1.22 Yes Yes

givenName No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

homePhone No 1.3.6.1.4.1.1466.115.121.1.50 Yes Yes

homePostalAddress No 1.3.6.1.4.1.1466.115.121.1.41 Yes Yes

initials No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

internationaliSDNNumber No 1.3.6.1.4.1.1466.115.121.1.36 Yes Yes

jpegPhoto No 1.3.6.1.4.1.1466.115.121.1.28 No Yes

l No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

labeledURI No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

mail No 1.3.6.1.4.1.1466.115.121.1.26 Yes Yes

manager No 1.3.6.1.4.1.1466.115.121.1.12 No Yes

messagingHostSerialNum No 1.3.6.1.4.1.1466.115.121.1.15 No No

messagingScrEntryUuid No 1.3.6.1.4.1.1466.115.121.1.15 No No

messagingTelephoneNum
ber

No 1.3.6.1.4.1.1466.115.121.1.15 No No

messagingUseEsnAccess
Code

No 1.3.6.1.4.1.1466.115.121.1.7 No No

messagingVpimAddress No 1.3.6.1.4.1.1466.115.121.1.15 No No

mobile No 1.3.6.1.4.1.1466.115.121.1.50 Yes Yes

nortelUserDefinedField No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

o No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

officeLocation No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

officialName No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

ou No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

pager No 1.3.6.1.4.1.1466.115.121.1.50 Yes Yes

photo No 1.3.6.1.4.1.1466.115.121.1.23 No Yes

physicalDeliveryOfficeNam
e

No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

postalAddress No 1.3.6.1.4.1.1466.115.121.1.41 Yes Yes
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Attribute Name
Requir

ed? Syntax Object Identifier (OID)

Can be
imported

using CSV
Subscriber
Synchroniz

ation?

Can
store
multip
le valu

es?

postalCode No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

postOfficeBox No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

preferredDeliveryMethod No 1.3.6.1.4.1.1466.115.121.1.14 No No

preferredDirectoryNumber No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

preferredEsnTelephoneNu
mber

No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

preferredExtension No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

preferredExternalTelephon
eNumber

No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

preferredLanguage No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

preferredName No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

registeredAddress No 1.3.6.1.4.1.1466.115.121.1.41 Yes Yes

roomNumber No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

secretary No 1.3.6.1.4.1.1466.115.121.1.12 No Yes

refer to Also No 1.3.6.1.4.1.1466.115.121.1.12 No Yes

serviceEndDate No 1.3.6.1.4.1.1466.115.121.1.24 Yes No

serviceStartDate No 1.3.6.1.4.1.1466.115.121.1.24 Yes No

sn Yes 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

st No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

street No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

subMgrTaskStatus No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

subscriberType No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

telephoneNumber No 1.3.6.1.4.1.1466.115.121.1.50 Yes Yes

teletexTerminalIdentifier No 1.3.6.1.4.1.1466.115.121.1.51 No Yes

telexNumber No 1.3.6.1.4.1.1466.115.121.1.52 Yes Yes

title No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

tmUserGroup No 1.3.6.1.4.1.1466.115.121.1.15 Yes No

uid No 1.3.6.1.4.1.1466.115.121.1.15 Yes Yes

userCertificate No 1.3.6.1.4.1.1466.115.121.1.8 No Yes

userPassword No 1.3.6.1.4.1.1466.115.121.1.40 No Yes

userPKCS12 No 1.3.6.1.4.1.1466.115.121.1.5 No Yes
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Attribute Name
Requir

ed? Syntax Object Identifier (OID)

Can be
imported

using CSV
Subscriber
Synchroniz

ation?

Can
store
multip
le valu

es?

userSMIMECertificate No 1.3.6.1.4.1.1466.115.121.1.5 No Yes

x121Address No 1.3.6.1.4.1.1466.115.121.1.36 Yes Yes

x500uniqueIdentifier No 1.3.6.1.4.1.1466.115.121.1.6 No Yes

Nortel subscriber schema attributes
Table 15 "Nortel subscriber schema attributes" (page 188) provides the
Nortel subscriber schema attribute name, origin, and whether or not it
is required.

Table 15
Nortel subscriber schema attributes

Attribute Name Origin Required?

sn person Yes

cn person Yes

userPassword person No

telephoneNumber person No

seeAlso person No

description person No

title organizationalPerson No

x121Address organizationalPerson No

registeredAddress organizationalPerson No

destinationIndicator organizationalPerson No

preferredDeliveryMethod organizationalPerson No

telexNumber organizationalPerson No

teletexTerminalIdentifier organizationalPerson No

internationaliSDNNumber organizationalPerson No

facsimileTelephoneNumber organizationalPerson No

street organizationalPerson No

postOfficeBox organizationalPerson No

postalCode organizationalPerson No

postalAddress organizationalPerson No

physicalDeliveryOfficeName organizationalPerson No
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ou organizationalPerson No

st organizationalPerson No

l organizationalPerson No

audio inetOrgPerson No

businessCategory inetOrgPerson No

carLicense inetOrgPerson No

departmentNumber inetOrgPerson No

displayName inetOrgPerson No

employeeNumber inetOrgPerson No

employeeType inetOrgPerson No

givenName inetOrgPerson No

homePhone inetOrgPerson No

homePostalAddress inetOrgPerson No

initials inetOrgPerson No

jpegPhoto inetOrgPerson No

labelledURI inetOrgPerson No

mail inetOrgPerson No

manager inetOrgPerson No

mobile inetOrgPerson No

o inetOrgPerson No

pager inetOrgPerson No

photo inetOrgPerson No

roomNumber inetOrgPerson No

secretary inetOrgPerson No

uid inetOrgPerson No

userCertificate inetOrgPerson No

x500uniqueIdentifier inetOrgPerson No

preferredLanguage inetOrgPerson No

userSMIMECertificate inetOrgPerson No

userPKCS12 inetOrgPerson No

officeLocation CND 1.0 No

country CND 1.0 No

esmGUID CND 1.0 No

serviceStartDate CND 1.0 No

serviceEndDate CND 1.0 No
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subscriberType CND 1.0 No

officialName CND 1.0 No

preferredName CND 1.0 No

combinedName CND 1.0 No

cpndName CND 1.0 No

nortelUserDefinedField CND 1.0 No

tmUserGroup CND 2.0 No

billingWebReportingAccessRights CND 2.0 No

preferredDirectoryNumber CND 2.0 No

preferredExternalTelephoneNumber CND 2.0 No

preferredESNTelephoneNumber CND 2.0 No

billingAccountCode CND 2.0 No

billingAuthorizationCode CND 2.0 No

messagingTelephoneNumber CND 2.1 No

messagingVpimAddress CND 2.1 No

messagingHostSerialNumber CND 2.1 No

messagingSrcEntryUUID CND 2.1 No

messagingUseEsnAccessCode CND 2.1 No

preferredExtension CND 2.1 No
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Appendix G
CSV File Format

CSV file format
When users synchronize a Comma Separated Values (CSV) file into
Common Network Directory (CND), they are asked to specify the format of
the file, either standard CSV or Microsoft CSV. This appendix explains the
rules of each format and the CND-specific rules that imported and exported
files must follow.

Rules that apply to both formats
Records and field values

CSV files are text files that contain a list of records separated by new-line
characters.

Each record contains field values separated by commas. For example,
consider a CSV file with the following contents:

a,b,c,d,e
f,g,h,i,j

This file has two records, each with five field values.

Field values with commas, semi-colons, and newlines
If a field value contains a comma or new-line, the entire field value must be
surrounded by double quotes. For example, consider a CSV file with the
following contents:

a,b,"c,d",e
"f,g",h,i,j

This file has three records, each with four field values. The first record’s
third field value has an embedded comma as does the second record’s
first field value.
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Quoted field values
Any field value can be surrounded by double quotes; they are only required
when the field value contains an embedded comma or new-line.

Text after a field value’s closing double quote but before the next comma is
ignored. For example, consider a CSV file with the following contents:

a,b,"c"XXX,d
"a"XXX,b,c,d

This file has two records, each with the same four field values (a, b, c, d).
XXX is ignored in both cases.

Empty field values
Empty field values are indicated by consecutive commas. For example,
consider a CSV file with the following contents:

a,,b,,c
a,b,,,,c

This file has two records. The first record has five field values where the
second and fourth are empty. The second record has six field values where
the third, fourth, and fifth are empty.

Empty lines
Empty lines and lines that only contain spaces and tabs are ignored. For
example, consider a CSV file with the following contents:

a,b,c,d,e

f,g,h,i,j

k,l,m,n,o

This file only has three records, even though it has five lines.

Differences between standard CSV format and Microsoft CSV format
Standard CSV format and Microsoft CSV format differ in their handling of:

• "Embedded quotes in quoted field values" (page 193)

• "Backslashes in quoted field values " (page 193)

• "Leading and trailing white space between field values " (page 193)
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Embedded quotes in quoted field values
Standard CSV and Microsoft CSV use a different character to escape
quotes embedded in quoted field values; standard CSV uses a backslash
while Microsoft CSV uses a second quote. For example, consider a CSV file
with the following contents:

"He said ""Hello""",b,c

If this file is parsed with a standard CSV parser, it reads the first field
value as "He said ", ignoring the quoted Hello. If this file is parsed with a
Microsoft™ CSV parser, it reads the first field value as "He said "Hello"".

Backslashes in quoted field values
In standard CSV, backslashes are special characters used to escape
quotes. Therefore, embedded backslashes must be escaped with a second
backslash. Backslashes that are not followed by a quote or backslash are
ignored. In Microsoft CSV, backslashes have no special significance. For
example, consider a CSV file with the following contents:

"C:\data\file.txt",a,b,c

A standard CSV parser reads the first field value as C:datafile.txt. A
Microsoft CSV parser reads the first field value as C:\data\file.txt.

Leading and trailing white space between field values
In standard CSV, leading and trailing white space between field values is
ignored. In Microsoft CSV, it is significant. For example, consider a CSV file
with the following contents:

a, b
, c , d

A standard CSV parser reads each field value as a single character, ignoring
the spaces. A Microsoft CSV parser includes the spaces in the field values.

CND-specific rules
Records with different numbers of fields

Prior to CND 2.1.90, each record that did not have exactly the same number
of field values as the first record was a failure and caused the entire import
operation to abort.

As of CND 2.1.90, records are allowed to have any number of fields. If a
record has fewer fields than the header, the remaining fields are taken as
null. If a record has more fields than the header, the extra fields are ignored.
For example, consider a CSV file with the following contents:

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



194 Appendix G CSV File Format

cn,sn,givenName
johndoe, doe, john
lyndasmythe, smythe, lynda
fredflintstone,flintstone
barneyrubble,rubble,barney,fatherofbambam

Using CND’s CSV subscriber import feature (in CND 2.1.90 or later) on this
file results in four entries being added to CND:

• cn=johndoe, sn=doe, givenName=john

• cn=lyndasmythe, sn=smythe, givenName=lynda

• cn=fredflintstone, sn=flintstone

• cn=barneyrubble, sn=rubble, givenName=barney

Note that Fred Flintstone’s givenName attribute does not exist because
his given name was not specified in the CSV file. Also note that Barney
Rubble’s additional information (fatherofbambam) is ignored.

Summary of CSV rules
Table 16 "CSV rules" (page 194) summarizes the CSV rules.

Table 16
CSV rules

CSV file content
CND interpretation
(Microsoft format)

CND interpretation
(standard format)

Record

Field values in a record are
separated by commas
a,b,c,d,e

field1: a
field2: b
field3: c
field4: d
field5: e

field1: a
field2: b
field3: c
field4: d
field5: e

Field values with embedded
comma

A value in quotes is one
field value, even if the value
contains a comma
a,b,"c,d",e

field1: a
field2: b
field3: c,d
field4: e

field1: a
field2: b
field3: c,d
field4: e

Field values with embedded
newline

A value in quotes is one
field value, even if the value
contains a newline
a,b,"c
d",e

field1: a
field2: b
field3: c

d
field4: e

field1: a
field2: b
field3: c

d
field4: e
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CSV file content
CND interpretation
(Microsoft format)

CND interpretation
(standard format)

Field values with quotes

In field values that start with a
quote, text after the end quote
is ignored. In field values that
contain quotes but do not
start with a quote, quotes are
part of the field value
a,b,"c"XXX,d
"e"XXX,f,g,h
i,j"k"l,m

Record1
field1: a
field2: b
field3: c
field4: d
Record2
field1: e
field2: f
field3: g
field4: h

Record3
field1: i
field2: j"k"l
field3: m

Record1
field1: a
field2: b
field3: c
field4: d
Record2
field1: e
field2: f
field3: g
field4: h
Record3

field1: i
field2: j"k"l
field3: m

Empty field values

Consecutive commas denote
empty field values
a,b,,,,c

field1: a
field2: b
field3:
field4:
field5:
field6: c

field1: a
field2: b
field3:
field4:
field5:
field6: c

Empty lines

Empty lines and lines that
only contain spaces and tabs
are ignored:
a,b,c,d
e,f,g,h

Record1
field1: a
field2: b
field3: c
field4: d
Record2
field1: e
field2: f
field3: g
field4: h

Record1
field1: a
field2: b
field3: c
field4: d
Record2
field1: e
field2: f
field3: g
field4: h

Embedded quotes in quoted
fields

Microsoft CSV uses a second
quote to escape embedded
quotes; generic CSV uses a
backslash
"Say""Hello""",b
"Say\"Hello\"",b

Record1
field1: Say"Hello"
field2: b
Record2
field1: Say\
field2: b

Record1
field1: Say
field2: b
Record2
field1: Say"Hello"
field2: b

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



196 Appendix G CSV File Format

CSV file content
CND interpretation
(Microsoft format)

CND interpretation
(standard format)

Backslashes in quoted fields

In Microsoft CSV, backslashes
have no special significance;
in standard CSV, backslashes
are special characters used to
escape quotes
"C:\ab\cd.tx",a

field1: C:\ab\cd.tx
field2: a

field1: C:abcd.tx
field2: a

Leading and trailing white
space

In Microsoft CSV, leading and
trailing white space between
field values is significant; in
standard CSV, it is ignored

a, b , c

field1: a
field2: b
field3: c

field1: a
field2: b
field3: c
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Appendix H
Unicode byte-order mark

The Unicode byte-order mark (BOM) is the Unicode character at code point
U+FEFF ("zero-width no-break space"), when that character is used to
denote the endianness of a string of UCS/Unicode characters encoded
in 16-bit Unicode Transformation Format (UTF-16) or 32-bit Unicode
Transformation Format (UTF-32) and/or as a marker to indicate that text
is encoded in 8-bit Unicode Transformation Format (UTF-8), UTF-16 or
UTF-32.

Table 17 "Encodings of the BOM by encoding scheme" (page 197) displays
the encodings of the byte-order marks by encoding scheme.

Table 17
Encodings of the BOM by encoding scheme

Encoding scheme Encoding of BOM

UTF-8 EF BB BF

UTF-16 Big Endian FE FF

UTF-16 Little Endian FF FE
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Appendix I
SSL Configuration

The Lightweight Directory Access Protocol (LDAP) sync agent can talk
to Common Network Directory (CND) and customer LDAP servers over
a Transaction Layer Security/Secure Socket Layer (TLS/SSL) encrypted
channel. Proper configuration of the server and client needs to be done
before secure communication can be carried out.

The relationship between LDAP sync client and directory servers is shown
in Figure 47 "LDAP sync client and directory servers" (page 199).

Figure 47
LDAP sync client and directory servers

Server configuration
CND

Refer to CND 2.2 User Guide for detailed instructions:

1. Acquire certificates.

2. Enable Secure Socket Layer (SSL) through the CND Manager Privacy
tab.
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Active Directory

Procedure 56
Setting up Active Directory for SSL

Step Action

1 Install the Enterprise Certificate Authority on the server where Active
Directory resides.

Refer to the following link for instructions: http://www.mi-
crosoft.com/windows2000/techinfo/planning/security/casetup-
steps.asp.

2 Start the Certificates snap-in in Microsoft Management Console
(MMC). Make sure a certificate with the domain controller template
is present in the personal certificate folder of the local computer (see
) If YES, continue with step 4.

3 In the Certificates snap-in, under folder Certificates (Local
Computer) > Personal > Certificates, request a new certificate
with domain controller template.

4 Restart the server.

—End—
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Appendix J
Third-party License Agreements

The following list identifies the third party software distributed as
components of the Common Network Directory (CND):

• OpenLDAP

• Sleepycat Software’s Berkeley DB

• OpenSSL

Copies of the open source license agreements for each of these systems is
included in electronic format with the software distribution. Nortel complies
with all other terms and conditions outlined in these license agreements.

CND 2.2 introduces the following third-party library:

• Tony Freixas’ Jwizard

• Apache Jakarta Commons

• Kohsuke Kawaguchi’s Args4J

• Ice Engineering’s Windows Registry API

• CSVReader

• MetaStuff Ltd.’s Dom4J

• Sun’s JNDI/LDAP booster pack

• The Werken Company’s Jaxen

• Netbeans

OpenLDAP end user licence agreement
The OpenLDAP Public License

Version 2.8, 17 August 2003
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Redistribution and use of this software and associated documentation
("Software"), with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions in source form must retain copyright statements and
notices,

2. Redistributions in binary form must reproduce applicable copyright
statements and notices, this list of conditions, and the following
disclaimer in the documentation and/or other materials provided with
the distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time.

Each revision is distinguished by a version number. You may use this
Software under terms of this license revision or under the terms of any
subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION
AND ITS CONTRIBUTORS ’’AS IS’’ AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S)
OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in
advertising or otherwise to promote the sale, use or other dealing in this
Software without specific, written prior permission. Title to copyright in this
Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California,
USA. All Rights Reserved. Permission to copy and distribute verbatim
copies of this document is granted.
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Berkeley DB by Sleepycat Software end user license agreement
$Id: LICENSE,v 12.1 2005/06/06 20:20:10 bostic Exp $

The following is the license that applies to this copy of the Berkeley DB
software. For a license to use the Berkeley DB software under conditions
other than those described here, or to purchase support for this software,
please contact Sleepycat Software by email at db@sleepycat.com, or on
the Web at http://www.sleepycat.com.

Copyright (c) 1990-2005 Sleepycat Software. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Redistributions in any form must be accompanied by information
on how to obtain complete source code for the DB software and
any accompanying software that uses the DB software. The source
code must either be included in the distribution or be available for
no more than the cost of distribution plus a nominal fee, and must be
freely redistributable under reasonable conditions. For an executable
file, complete source code means the source code for all modules it
contains. It does not include source code for modules or files that
typically accompany the major components of the operating system
on which the executable file runs.

THIS SOFTWARE IS PROVIDED BY SLEEPYCAT SOFTWARE ’’AS IS’’
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT,
ARE DISCLAIMED. IN NO EVENT SHALL SLEEPYCAT SOFTWARE
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Copyright (c) 1990, 1993, 1994, 1995

The Regents of the University of California. All rights reserved.
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Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND
CONTRIBUTORS ’’AS IS’’ AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 1995, 1996

The President and Fellows of Harvard University. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may
be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY HARVARD AND ITS CONTRIBUTORS
’’AS IS’’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
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DISCLAIMED. IN NO EVENT SHALL HARVARD OR ITS CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

OpenSSL end user license agreement
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.

Refer to the text below for the actual license texts. Actually both licenses
are BSD-style Open Source licenses. In case of any license issues related
to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License
Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgment: "This product includes
software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not
be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor
may "OpenSSL" appear in their names without prior written permission
of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment: "This product includes software developed
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by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ’’AS IS’’
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim Hudson
(tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights
reserved.

This package is an SSL implementation written by Eric Young
(eay@cryptsoft.com). The implementation was written so as to conform with
Netscape’s SSL. This library is free for commercial and non-commercial use
as long as the following conditions are adhered to. The following conditions
apply to all code found in this distribution, be it the RC4, RSA,lhash, DES,
etc., code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the holder is
Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the
code are not to be removed. If this package is used in a product, Eric
Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list
of conditions and the following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgement: "This product includes
cryptographic software written by Eric Young (eay@cryptsoft.com)" The
word ’cryptographic’ can be left out if the routines from the library being
used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof)
from the apps directory (application code) you must include an
acknowledgement: "This product includes software written by Tim
Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ’’AS IS’’ AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or
derivative of this code cannot be changed. i.e. this code cannot simply
be copied and put under another distribution licence [including the GNU
Public Licence.]

JWizard by Tony Freixas end user license agreement
The intent of this document is to state the conditions under which a Package
may be copied, such that the Copyright Holder maintains some semblance
of artistic control over the development of the package, while giving the users
of the package the right to use and distribute the Package in a more-or-less
customary fashion, plus the right to make reasonable modifications.

"Package" refers to the collection of files distributed by the Copyright
Holder, and derivatives of that collection of files created through textual
modification.
"Standard Version" refers to such a Package if it has not been modified,
or has been modified in accordance with the wishes of the Copyright
Holder.
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"Copyright Holder" is whomever is named in the copyright or copyrights
for the package.
"You" is you, if you’re thinking about copying or distributing this Package.
"Reasonable copying fee" is whatever you can justify on the basis of
media cost, duplication charges, time of people involved, and so on.
(You will not be required to justify it to the Copyright Holder, but only to
the computing community at large as a market that must bear the fee.)
"Freely Available" means that no fee is charged for the item itself, though
there may be fees involved in handling the item. It also means that
recipients of the item may redistribute it under the same conditions they
received it.

1. You may make and give away verbatim copies of the source form of the
Standard Version of this Package without restriction, provided that you
duplicate all of the original copyright notices and associated disclaimers.

2. You may apply bug fixes, portability fixes and other modifications derived
from the Public Domain or from the Copyright Holder. A Package
modified in such a way shall still be considered the Standard Version.

3. You may otherwise modify your copy of this Package in any way,
provided that you insert a prominent notice in each changed file stating
how and when you changed that file, and provided that you do at least
ONE of the following:

a. place your modifications in the Public Domain or otherwise make
them Freely Available, such as by posting said modifications to
Usenet or an equivalent medium, or placing the modifications on a
major archive site such as ftp.uu.net, or by allowing the Copyright
Holder to include your modifications in the Standard Version of the
Package.

b. use the modified Package only within your corporation or
organization.

c. rename any non-standard executables so the names do not conflict
with standard executables, which must also be provided, and provide
a separate manual page for each non-standard executable that
clearly documents how it differs from the Standard Version.

d. make other distribution arrangements with the Copyright Holder.

4. You may distribute the programs of this Package in object code or
executable form, provided that you do at least ONE of the following:

a. distribute a Standard Version of the executables and library files,
together with instructions (in the manual page or equivalent) on
where to get the Standard Version.

b. accompany the distribution with the machine-readable source of the
Package with your modifications.
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c. accompany any non-standard executables with their corresponding
Standard Version executables, giving the non-standard executables
non-standard names, and clearly documenting the differences in
manual pages (or equivalent), together with instructions on where to
get the Standard Version.

d. make other distribution arrangements with the Copyright Holder.

5. You may charge a reasonable copying fee for any distribution of this
Package. You may charge any fee you choose for support of this
Package. You may not charge a fee for this Package itself. However,
you may distribute this Package in aggregate with other (possibly
commercial) programs as part of a larger (possibly commercial) software
distribution provided that you do not advertise this Package as a product
of your own.

6. The scripts and library files supplied as input to or produced as output
from the programs of this Package do not automatically fall under the
copyright of this Package, but belong to whomever generated them, and
may be sold commercially, and may be aggregated with this Package.

7. C or perl subroutines supplied by you and linked into this Package shall
not be considered part of this Package.

8. Aggregation of this Package with a commercial distribution is always
permitted provided that the use of this Package is embedded; that is,
when no overt attempt is made to make this Package’s interfaces visible
to the end user of the commercial distribution. Such use shall not be
construed as a distribution of this Package.

9. The name of the Copyright Holder may not be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS PACKAGE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE
IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

Apache Jakarta Commons end user license agreement
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND
DISTRIBUTION

1. Definitions.
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• "License" shall mean the terms and conditions for use, reproduction,
and distribution as defined by Sections 1 through 9 of this document.

• "Licensor" shall mean the copyright owner or entity authorized by the
copyright owner that is granting the License.

• "Legal Entity" shall mean the union of the acting entity and all other
entities that control, are controlled by, or are under common control
with that entity. For the purposes of this definition, "control" means (i)
the power, direct or indirect, to cause the direction or management of
such entity, whether by contract or otherwise, or (ii) ownership of fifty
percent (50%) or more of the outstanding shares, or (iii) beneficial
ownership of such entity.

• "You" (or "Your") shall mean an individual or Legal Entity exercising
permissions granted by this License.

• "Source" form shall mean the preferred form for making
modifications, including but not limited to software source code,
documentation source, and configuration files.

• "Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and
conversions to other media types.

• "Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by
a copyright notice that is included in or attached to the work (an
example is provided in the Appendix below).

• "Derivative Works" shall mean any work, whether in Source or
Object form, that is based on (or derived from) the Work and for
which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship.
For the purposes of this License, Derivative Works shall not include
works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

• "Contribution" shall mean any work of authorship, including the
original version of the Work and any modifications or additions to
that Work or Derivative Works thereof, that is intentionally submitted
to Licensor for inclusion in the Work by the copyright owner or by
an individual or Legal Entity authorized to submit on behalf of the
copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication
sent to the Licensor or its representatives, including but not limited
to communication on electronic mailing lists, source code control
systems, and issue tracking systems that are managed by, or on
behalf of, the Licensor for the purpose of discussing and improving
the Work, but excluding communication that is conspicuously
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marked or otherwise designated in writing by the copyright owner
as "Not a Contribution."

• "Contributor" shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and
subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this
License, each Contributor hereby grants to You a perpetual, worldwide,
non-exclusive, no-charge, royalty-free, irrevocable copyright license
to reproduce, prepare Derivative Works of, publicly display, publicly
perform, sublicense, and distribute the Work and such Derivative Works
in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this
License, each Contributor hereby grants to You a perpetual, worldwide,
non-exclusive, no-charge, royalty-free, irrevocable (except as stated in
this section) patent license to make, have made, use, offer to sell, sell,
import, and otherwise transfer the Work, where such license applies
only to those patent claims licensable by such Contributor that are
necessarily infringed by their Contribution(s) alone or by combination
of their Contribution(s) with the Work to which such Contribution(s)
was submitted. If You institute patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses granted
to You under this License for that Work shall terminate as of the date
such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or
Derivative Works thereof in any medium, with or without modifications,
and in Source or Object form, provided that You meet the following
conditions:

a. You must give any other recipients of the Work or Derivative Works a
copy of this License; and

b. You must cause any modified files to carry prominent notices stating
that You changed the files; and

c. You must retain, in the Source form of any Derivative Works that You
distribute, all copyright, patent, trademark, and attribution notices
from the Source form of the Work, excluding those notices that do
not pertain to any part of the Derivative Works; and

d. If the Work includes a "NOTICE" text file as part of its distribution,
then any Derivative Works that You distribute must include a
readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part
of the Derivative Works, in at least one of the following places:

Nortel Communication Server 1000
Common Network Directory 2.2 Administration

NN43050-101 02.05 Standard
Release 5.5 1 February 2008

Copyright © 2008, Nortel Networks

.



212 Appendix J Third-party License Agreements

within a NOTICE text file distributed as part of the Derivative Works;
within the Source form or documentation, if provided along with the
Derivative Works; or, within a display generated by the Derivative
Works, if and wherever such third-party notices normally appear.
The contents of the NOTICE file are for informational purposes only
and do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside or as
an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the
License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions for
use, reproduction, or distribution of Your modifications, or for any such
Derivative Works as a whole, provided Your use, reproduction, and
distribution of the Work otherwise complies with the conditions stated
in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any
Contribution intentionally submitted for inclusion in the Work by You to
the Licensor shall be under the terms and conditions of this License,
without any additional terms or conditions. Notwithstanding the above,
nothing herein shall supersede or modify the terms of any separate
license agreement you may have executed with Licensor regarding
such Contributions.

6. Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,
except as required for reasonable and customary use in describing the
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to
in writing, Licensor provides the Work (and each Contributor provides
its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES
OR CONDITIONS OF ANY KIND, either express or implied,
including, without limitation, any warranties or conditions of TITLE,
NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining
the appropriateness of using or redistributing the Work and assume any
risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in
tort (including negligence), contract, or otherwise, unless required by
applicable law (such as deliberate and grossly negligent acts) or agreed
to in writing, shall any Contributor be liable to You for damages, including
any direct, indirect, special, incidental, or consequential damages of
any character arising as a result of this License or out of the use or
inability to use the Work (including but not limited to damages for loss
of goodwill, work stoppage, computer failure or malfunction, or any and
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all other commercial damages or losses), even if such Contributor has
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work
or Derivative Works thereof, You may choose to offer, and charge a
fee for, acceptance of support, warranty, indemnity, or other liability
obligations and/or rights consistent with this License. However, in
accepting such obligations, You may act only on Your own behalf and on
Your sole responsibility, not on behalf of any other Contributor, and only
if You agree to indemnify, defend, and hold each Contributor harmless
for any liability incurred by, or claims asserted against, such Contributor
by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with
the fields enclosed by brackets "[]" replaced with your own identifying information.
(Don’t include the brackets!) The text should be enclosed in the appropriate comment
syntax for the file format. We also recommend that a file or class name and description
of purpose be included on the same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may
not use this file except in compliance with the License. You may obtain a
copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and
limitations under the License.

Args4J by Kohsuke Kawaguchi end user license agreement
Copyright (c) 2003, Kohsuke Kawaguchi All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
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• Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Windows Registry API by Ice Engineering end user license
agreement

Authored by Timothy Gerard Endres

This work has been placed into the public domain. You may use this work in
any way and for any purpose you wish.

THIS SOFTWARE IS PROVIDED AS-IS WITHOUT WARRANTY OF ANY
KIND, NOT EVEN THE IMPLIED WARRANTY OF MERCHANTABILITY.
THE AUTHOR OF THIS SOFTWARE, ASSUMES _NO_ RESPONSIBILITY
FOR ANY CONSEQUENCE RESULTING FROM THE USE,
MODIFICATION, OR REDISTRIBUTION OF THIS SOFTWARE.

CSVReader end user license agreement
No license information available.

Dom4j by MetaStuff Ltd. end user license agreement
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation
("Software"), with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain copyright statements and
notices. Redistributions must also contain a copy of this document.
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2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. The name "DOM4J" must not be used to endorse or promote products
derived from this Software without prior written permission of MetaStuff,
Ltd. For written permission, please contact dom4j-info@metastuff.com.

4. Products derived from this Software may not be called "DOM4J" nor
may "DOM4J" appear in their names without prior written permission of
MetaStuff, Ltd. DOM4J is a registered trademark of MetaStuff, Ltd.

5. Due credit should be given to the DOM4J Project: http://www.dom4j.org

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND
CONTRIBUTORS ‘‘AS IS’’ AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

JNDI/LDAP booster pack by Sun end user license agreement
No license information available.

Jaxen by The Werken Company user license agreement
$Id: LICENSE.txt,v 1.5 2006/02/05 21:49:04 elharo Exp $

Copyright 2003-2006 The Werken Company. All Rights Reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
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Neither the name of the Jaxen Project nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Netbeans end user license agreement
No license information available.
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Glossary

Attribute
A single named piece of data within an object class

BOM
Unicode byte order mark

CN
Common Name

CallPilot network authority
User-defined CallPilot queried by CND for the list of all CallPilot hosts in its
networking tree

CND
Common Network Directory

CND GAB entry
CND subscriber entry containing CallPilot-specific attributes

CND GAB entry cleaning
CND GAB entry whose corresponding CallPilot local address book entry
has been deleted

CND subscriber entry
An entry on CND that stores information about subscribers

CND Service
LDAP Directory Service

CSV
Comma Separated Values

DN
Distinguished Name
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GAB
Global Address Book

GUI
Graphical User Interface

IP
Internet Protocol

JNDI
Java Naming and Directory Interface

JRE
Java Runtime Environment

LDAP
Lightweight Directory Access Protocol

Object Class
A named collection of attributes used to describe an object in the directory

OSI
Open Systems Interconnect

Schema
The complete collection of objects, their attributes, and rules that dictate the
type of data that can be stored in a directory service.

SHA
Secure Hash Algorithm

SSL
Secure Socket Layer

TLS
Transaction Layer Security

TM
Nortel Communication Server 1000 Telephony Manager

UI
User Interface

VPIM
Voice Profile for Internet Mail
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account password 55
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Administrator account 57
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